How To...
Engineering Guide

A Simple Substation Grounding Grid Analysis
This page is intentionally left blank
## REVISION RECORD

<table>
<thead>
<tr>
<th>Date</th>
<th>Version Number</th>
<th>Revision Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>September 1996</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>October 1996</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>December 1997</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>December 1998</td>
<td>7</td>
<td>0</td>
</tr>
<tr>
<td>January 1999</td>
<td>7</td>
<td>1</td>
</tr>
<tr>
<td>January 2000</td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>September 2000</td>
<td>9</td>
<td>0</td>
</tr>
<tr>
<td>November 2002</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>May 2003</td>
<td>10</td>
<td>1</td>
</tr>
<tr>
<td>June 2004</td>
<td>11</td>
<td>0</td>
</tr>
<tr>
<td>December 2006</td>
<td>13</td>
<td>0</td>
</tr>
<tr>
<td>January 2012</td>
<td>14</td>
<td>0</td>
</tr>
<tr>
<td>June 2017</td>
<td>16</td>
<td>0</td>
</tr>
</tbody>
</table>
SPECIAL NOTE

As SES software is constantly evolving, with frequently created updates, minor discrepancies may appear between this How To manual illustrations of the software interface and the present software version interface. These differences are cosmetic in nature and do not impact the validity of the guidance and procedures provided herein. Furthermore, small differences in the reported and plotted numerical values may exist due to continuous enhancements of the computation algorithms.
This page is intentionally left blank
# TABLE OF CONTENTS

**CHAPTER 1**  
INTRODUCTION .................................................................................................................. 1-1  
1.1 OBJECTIVE ................................................................................................................ 1-1  
1.2 COMPUTER MODELING TOOL .................................................................................. 1-2  
1.3 METHODOLOGY OF THE GROUNDING DESIGN .................................................. 1-3  
1.4 ORGANIZATION OF THE MANUAL ........................................................................ 1-3  
1.5 SOFTWARE NOTE ....................................................................................................... 1-4  
1.6 FILE NAMING CONVENTIONS .................................................................................. 1-4  
1.7 DEMO EVALUATION .................................................................................................. 1-6  
1.8 WORKING DIRECTORY ............................................................................................. 1-6  
1.9 INPUT AND OUTPUT FILES USED IN TUTORIAL ................................................ 1-6  

**CHAPTER 2**  
DESCRIPTION OF THE PROBLEM & DEFINITION OF THE SYSTEM DATA ........... 2-1  
2.1 THE SUBSTATION GROUNDING SYSTEM ................................................................ 2-1  
2.2 THE OVERHEAD TRANSMISSION LINE NETWORK ........................................ 2-2  
2.3 THE SUBSTATION TERMINALS ............................................................................... 2-2  
2.4 THE SOIL CHARACTERISTICS .................................................................................. 2-3  

**CHAPTER 3**  
SOIL RESISTIVITY INTERPRETATION USING RESAP ...................................................... 3-1  
3.1 A HORIZONTAL TWO-LAYER SOIL MODEL ......................................................... 3-1  
3.2 PREPARATION OF THE RESISTIVITY INPUT FILE ............................................. 3-1  
3.2.1 START UP PROCEDURES .................................................................................. 3-2  
3.2.2 DATA ENTRY ...................................................................................................... 3-9  
3.2.3 HOW TO PRODUCE THE RESAP INPUT FILE .............................................. 3-12  
3.3 SUBMISSION OF THE RESAP RUN .......................................................................... 3-13  
3.4 EXTRACTION OF RESAP COMPUTATION RESULTS ............................................. 3-14  

**CHAPTER 4**  
COMPUTATION OF GROUND GRID PERFORMANCE USING MALT .......................... 4-1  
4.1 PREPARATION OF THE MALT INPUT FILE ........................................................... 4-1  
4.1.1 START UP PROCEDURES .................................................................................. 4-1  
4.1.2 DATA ENTRY ...................................................................................................... 4-3  
4.2 SUBMISSION OF THE MALT RUN ........................................................................... 4-7  
4.2.1 SUBMIT COMPUTATION PROGRAM USING SESCAD .................................. 4-7  
4.2.2 SUBMIT COMPUTATION PROGRAM USING CDEGS .................................... 4-8
<table>
<thead>
<tr>
<th>TABLE OF CONTENTS (CONT’D)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page</strong></td>
</tr>
</tbody>
</table>

4.3 EXTRACTION OF MALT COMPUTATION RESULTS ......................................................... 4-9
  4.3.1 OBTAIN GROUND RESISTANCE ........................................................................... 4-9
  4.3.2 PLOT SCALAR POTENTIALS AND TOUCH VOLTAGES ........................................... 4-11
  4.3.3 PLOT LEAKAGE CURRENTS ............................................................................. 4-12

**CHAPTER 5**

FAULT CURRENT DISTRIBUTION ANALYSIS USING FCDIST ........................................ 5-1
  5.1 INTRODUCTION ....................................................................................................... 5-1
  5.2 PREPARATION OF THE FCDIST INPUT FILE ......................................................... 5-2
    5.2.1 START UP PROCEDURES ................................................................................ 5-2
    5.2.2 DATA ENTRY .................................................................................................. 5-3
    5.2.3 HOW TO PRODUCE THE FCDIST INPUT FILE .............................................. 5-6
  5.3 SUBMISSION OF THE FCDIST RUN ...................................................................... 5-6
  5.4 EXTRACTION OF THE FCDIST COMPUTATION RESULTS .................................... 5-7

**CHAPTER 6**

PERFORMANCE EVALUATION OF EAST CENTRAL SUBSTATION .................................. 6-1
  6.1 SAFETY CRITERIA ................................................................................................... 6-1
    6.1.1 TOUCH VOLTAGES ....................................................................................... 6-2
    6.1.2 STEP VOLTAGES .......................................................................................... 6-2
    6.1.3 GPR DIFFERENTIALS ................................................................................... 6-3
    6.1.4 DETERMINING SAFE TOUCH AND STEP VOLTAGES CRITERIA.................. 6-3
  6.2 GROUND POTENTIAL RISE, TOUCH AND STEP VOLTAGES ................................ 6-6
    6.2.1 EXAMINE GPR AND TOUCH VOLTAGES ..................................................... 6-6
    6.2.2 EXAMINE STEP VOLTAGES ....................................................................... 6-10
    6.2.3 EXAMINE LEAKAGE CURRENTS ................................................................ 6-11

**CHAPTER 7**

REINFORCING THE GROUNDING SYSTEM ................................................................ 7-1
  7.1 SESCAD INPUT MODE ......................................................................................... 7-1
  7.2 EXPLORE RESULTS BY GRSERVER .................................................................... 7-8
  7.3 EXPLORE RESULTS BY SESSYSTEMVIEWER .................................................... 7-10

**CHAPTER 8**

CONCLUSION ............................................................................................................. 8-1

**APPENDIX A**

COMMAND INPUT MODE .............................................................................................. A-1

**APPENDIX B**

SESCONVERTER ......................................................................................................... B-1
This page is intentionally left blank
CHAPTER 1
INTRODUCTION

1.1 OBJECTIVE

This How To… Engineering Guide shows you how to carry out a typical substation grounding design using the AutoGround, MultiGround or CDEGS software packages. A step-by-step approach is used to illustrate how to use the Windows Toolbox interface to input your data, run the pertinent computation modules and explore the computation results.

Please note that you may press the F1 key at any time to display context-sensitive help pertinent to the topic to which you have given focus with your mouse. You may also access the complete online help file by selecting the Interface Help (F1) option from the Manuals drop down from the Help tab of the CDEGS start-up window.

If you are anxious to start entering data and running CDEGS you may do so by skipping the rest of this chapter and Chapter 2. We strongly recommend, however, that you refer to the skipped sections to clarify items related to input files, system configuration and data, file sharing and design methodology.

The grounding analysis problem is illustrated in Figure 1.1. A new 230 kV Substation (named East Central) is planned. It will be interconnected to the rest of the network via three transmission lines terminating at three different substations, namely Terminals Greenbay, Newhaven and Hudson respectively. The objective of the analysis is to provide a new grid design for the East Central Substation. The final design is to limit touch and step voltages to safe levels for personnel within the substation area, based on up-to-date system data, appropriate measurement techniques and instrumentation, and state-of-the-art computer modeling methods.

Figure 1.1 Illustration of the Grounding Analysis Problem.
1.2 COMPUTER MODELING TOOL

SES’s AutoGround, or MultiGround or CDEGS is used to model the field measurements (i.e., soil resistivities and grounding system impedance) and interpret the measured data, to compute the distribution of fault current between the transmission line static wires, distribution line neutral wires, and the substation grounding grid, and to simulate a representative phase-to-ground fault in the substation in order to compute touch voltages, grid potentials, and grounding cable current flows throughout the substation.

The computation program modules RESAP, MALT and FCDIST are used for this study. This tutorial also illustrates the use of some of SES’s input and output processors.

Presently, the Computation modules RESAP, MALT, FCDIST and SPLITS are the only components that can transfer or share data. That transfer or share mechanism is performed through common share database files that communicate important information from one module to the other and to the Output processors as shown in Figure 1.2. When processed in the correct sequence, the exchange of data occurs adequately. Otherwise, it is preferable to transfer the required information by specifying it directly in the appropriate input fields. The correct sequence is as follows:

1. Run RESAP: The soil model characteristics are stored in the Share file (SF_JobID.F11).
2. Run MALT: The soil model (calculated by RESAP) is read from the Share file and MALT stores the grid impedance in the Share file (SF_JobID.F11).
3. Run FCDIST: The grid impedance (calculated by MALT) is read and FCDIST or SPLITS stores the fault current in the Share file (SF_JobID.F11).
4. Run an Output Module: The fault current (calculated by FCDIST) is read from the Share file (SF_JobID.F11) and the fault current defined in MALT is then adjusted proportionally. All MALT computed results are also adjusted accordingly.
1.3 METHODOLOGY OF THE GROUNDING DESIGN

The grounding design analysis is normally carried out in six major steps as follows:

**Step 1** The first step of the study is aimed at determining an equivalent soil model to the real earth structure using the RESAP soil resistivity interpretation computation module. Several soil type models can be selected by the designer as an approximation to the real soil (uniform, two-layer, multilayer, exponential, etc.).

**Step 2** Based on experience and on the substation ground bonding requirements, a preliminary economical grounding system configuration is developed and analyzed using the MALT grounding analysis computation module based on the equivalent soil model developed in Step 1 and assuming a 1,000 or 10,000 A fault current discharged by the grid (initial design).

**Step 3** The actual fault current discharged by the substation grounding system is then determined using the FCDIST fault current distribution computation module.

**Step 4** The calculated results are analyzed using one of the output processors and various computation plots. Printout reports are examined to determine if all design requirements are met. In particular, the safe touch and step voltage thresholds are determined based on the applicable standards and regulations and those are compared to the computed values.

**Step 5** If all design requirements are not met or if all these requirements are exceeded by a considerable margin suggesting possible significant savings, design modifications to the grounding system or to the transmission line network are made and the design analysis is restarted at Step 2.

**Step 6** If seasonal soil resistivity variations must be accounted for then the entire analysis is repeated for every realistic soil scenario and the worst-case scenario is used to develop the final design.

1.4 ORGANIZATION OF THE MANUAL

Following the design methodology illustrated above, the manual is organized as follows:

Chapter 2 describes the problem being modeled and defines the system data that is required for the study.

Chapter 3 shows how to use the RESAP computation module to analyze the soil resistivity data based on the measurements taken at East Central Substation (Step 1).

Chapter 4 presents the initial design of the grounding system. It describes the detailed computer model of the East Central Substation grounding grid and shows how to use the MALT computation module to determine the grounding grid impedance that will be used in the computation of the fault current distribution in Chapter 5 (Step 2).

Chapter 5 describes how to use the FCDIST module to determine the fault current distribution (for the fault current simulations) between the transmission line static wires, distribution line neutral wires, and the substation grounding grid (Step 3).
Chapter 6 presents the ANSI/IEEE safety criteria applicable to the substation grounding. The fault simulation results are presented in graphical and tabular form. Grid potentials, touch voltages, and grid conductor leakage currents are provided in detail. Step-by-step instructions about how to obtain these results are described (Step 4).

Chapter 7 presents the design of the reinforced grounding systems. It describes how to repeat the computations from Chapter 4 to 6 to ensure that the safety criteria are met (Step 5).

In Chapter 8, the conclusions of the study are summarized. Step 6 is not considered in this manual.

### 1.5 SOFTWARE NOTE

This tutorial assumes that the reader is using the Windows version of CDEGS.

### 1.6 FILE NAMING CONVENTIONS

It is important to know which input and output files are created by the CDEGS software. All CDEGS input and output files have the following naming convention:

```
XY_JobID.Fnn
```

where *XY* is a two-letter *abbreviation* corresponding to the name of the program which created the file or which will read the file as input. The *JobID* consists of string of characters and numbers that is used to label all the files produced during a given CDEGS run. This helps identify the corresponding input, computation, results and plot files. The *nn* are two digits used in the extension to indicate the type of file.

The abbreviations used for the various CDEGS modules are as follows:

<table>
<thead>
<tr>
<th>Application</th>
<th>Abbreviation</th>
<th>Application</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESAP</td>
<td>RS</td>
<td>FCDIST</td>
<td>FC</td>
</tr>
<tr>
<td>MALT</td>
<td>MT</td>
<td>HIFREQ</td>
<td>HI</td>
</tr>
<tr>
<td>MALZ</td>
<td>MZ</td>
<td>FFTSES</td>
<td>FT</td>
</tr>
<tr>
<td>TRALIN</td>
<td>TR</td>
<td>SESEnviroPlus</td>
<td>TR</td>
</tr>
<tr>
<td>SPLIT5</td>
<td>SP</td>
<td>SESShield-3D</td>
<td>SD</td>
</tr>
<tr>
<td>SESTLC</td>
<td>TC</td>
<td>ROWCAD</td>
<td>RC</td>
</tr>
<tr>
<td>SESShield</td>
<td>LS</td>
<td>SESeBundle</td>
<td>BE</td>
</tr>
<tr>
<td>GRSPLIT5-3D</td>
<td>SP</td>
<td>CorrCAD</td>
<td>CC</td>
</tr>
<tr>
<td>AutoGroundDesign</td>
<td>AD</td>
<td>SESTThreshold</td>
<td>TH</td>
</tr>
<tr>
<td>SESAmpacity</td>
<td>AP</td>
<td>SESCrossSection</td>
<td>XS</td>
</tr>
<tr>
<td>SESEmpedance</td>
<td>FM</td>
<td>CSIRPS*</td>
<td>CS</td>
</tr>
</tbody>
</table>

* The CSIRPS module is used internally by the graphics and report generating interfaces.

The following four types of files are often used and discussed when a user requests technical support for the software:
 FTP  Command input file (for computation applications programs). This is a text file that can be opened by any text editor (WordPad or Notepad) and can be modified manually by experienced users.

 FTP  Computation results file (for computation applications programs). This is a text file that can be opened by any text editor (WordPad or Notepad).

 FTP  Computation database file (for computation applications programs). This is a binary file that can only be loaded by the CDEGS software for reports and graphics display.

 FTP  Computation database file (for computation applications programs MALZ and HIFREQ only). This is a binary file that stores the current distribution to recover.

For further details on CDEGS file naming conventions and JobID, consult the CDEGS Help by pressing F1 in the main CDEGS interface and navigating to **Using CDEGS – Working With CDEGS Projects – File Naming Conventions**.

In CDEGS-Legacy, the same help entry is available under the menu **Help | Contents | File Naming Conventions**.
1.7 DEMO EVALUATION

In order to be able to evaluate SES Software without a license, you should install the software as a demo. This will give you access to the computed results without extra effort.

In the demo environment, the input and output files of the case studies in this tutorial are already installed under the SES Software documents subfolder, HowTo; e.g., “C:\Users\Public\Documents\SES Software\<version>\HowTo\CDEGS\GROUND”, where <version> is the version number of SES Software. You must use this default location as the working directory when the software is installed as a demo.

1.8 WORKING DIRECTORY

A Working Directory is a folder where all input and output files of case studies are stored and created. If you are doing a demo evaluation, the working directory for this tutorial is already set up by the installation. If you have a valid SES Software license to use the programs that are covered by this tutorial, we recommend using the following working directory to follow the tutorial.

<drive>\CDEGS HowTo\GROUND

e.g., C:\CDEGS HowTo\GROUND

1.9 INPUT AND OUTPUT FILES USED IN TUTORIAL

All input and output files used in this tutorial are supplied from the SES Software distribution. When the software is installed as a demo, the full set of distribution files are available under the default SES Software documents subfolder, Setup.Z, where “Z” is part of the version number of the software. Note that the package file, SESXY.EXE, may be unpacked at any time (“X” and “Y” are part of the version number of the software) if the tutorial is being followed without a demo installation.

The original files of this tutorial can be found in the distribution under the following subfolders:

Input Files:   Examples\Official\HowTo\CDEGS\GROUND\inputs
Output Files:  Examples\Official\HowTo\CDEGS\GROUND\outputs

If you prefer to load the input files into the software and simply follow the tutorial, copy all the files from the inputs subfolder in the distribution to your working directory. The outputs subfolder contains the precomputed results that can be used if you do not have a valid license. The above locations can also be used to refresh files in the working directory if you feel the need to do so. Note that the files found in both the inputs and the outputs subfolders should be copied directly into the working directory, not into subdirectories.

After the tutorial has been completed, you may wish to explore the other how-to engineering manuals; they can be accessed from the program shortcut, SES Software X.Y > Documentation > Manuals. The same manuals can also be retrieved from the SES Software distribution under the subfolder, PDF\HowTo Manuals.
CHAPTER 2
DESCRIPTION OF THE PROBLEM & DEFINITION OF THE SYSTEM DATA

The system being modeled is located in an isolated area (i.e., not in an urban area and not close to any pipelines or water main structures) where there are no major geological disturbances (ocean, rivers, valleys, hills, etc.). It consists of the following four major components: (see Figure 2.1)

1. The substation and associated grounding system of the substation under study;
2. An overhead transmission line network;
3. Various substations (terminals) from which power is fed to the transmission line network;
4. The characteristics of the soil at the substation site under study.

2.1 THE SUBSTATION GROUNDING SYSTEM

Figure 2.2 shows the configuration of the initial design (first attempt) of the East Central grounding grid. The initial design consists of a 350 foot by 200 foot (107 m x 61 m) rectangular grid buried at a depth of 1.5 feet (0.46 m) deep. Each conductor has a 0.017 foot (0.2" or 0.6 cm) radius. The grid is made of 9 equally spaced conductors along the X-axis and 7 equally spaced conductors along the Y-axis. The perimeter of the grid was defined such that the outermost conductors are located exactly 3.3 feet (1m) outside the edge of the fence to protect people standing outside the substation from excessive touch voltages. The fence is regularly connected to the outermost conductors. However, the fence posts (which are metallic) were not modeled for simplicity. It is an easy task to add the fence posts using the “Create” screen in the Input Toolbox or the SESCAD module as explained later. The initial ground resistance of the East Central Substation is 0.507 $\Omega$ as will be determined by the MALT computation module.
2.2 THE OVERHEAD TRANSMISSION LINE NETWORK

There are three double circuit transmission lines leaving the East Central substation. The average span length of the transmission lines is 1056' (322 m). The first transmission line is 65 spans long (13 miles or 20.9 km) and is connected to the Greenbay substation (terminal). The other transmission line is 34 spans long (6.8 miles or 10.94 km) and is connected to the Newhaven substation. The remaining transmission line is connected to the Hudson substation and is 26 spans long (5.2 miles or 8.4 km). Each tower has two 7 No. 8 Alumoweld type neutral shield wires (shield wires) and the phase wires are 795 MCM Drake. The GMR and the average AC resistance of the neutral wires are 0.0021 feet (0.00064008 m) and 2.83058 Ω/mile (1.75884 Ω/km), respectively. Figure 2.3 shows a cross section of the transmission line used in this study.

The ground resistances of the transmission line towers in the Greenbay - East Central arm of the network, which are 1/5 mile (1056') apart, are all assumed to be equal to 10 Ω. The towers in the Hudson - East Central and Newhaven - East Central arms, which are also 1/5 mile apart, have a higher resistance of 28 Ω.

![Figure 2.3 Transmission Line Configuration.](image)

2.3 THE SUBSTATION TERMINALS

The ground resistances of the terminals are equal to 0.2 Ω, 0.3 Ω and 0.3 Ω for Greenbay, Hudson and Newhaven terminals, respectively. Figure 2.4 illustrates a circuit diagram of the power system under study during a phase-to-ground fault condition on Phase A.
Chapter 2. Description of the Problem & Definition of the System Data

In this study, we assume that the highest fault current discharged by the East Central Substation grid occurs for a 230 kV single-phase-to-ground fault at East Central Substation on Phase A of Circuit 2. We also assume that short-circuit calculations carried out by the power utility provide the following fault current contributions from Phase A of each terminal substation:

- **Greenbay**: 1226-j 5013 A
- **Hudson**: 722 - j 6453 A
- **Newhaven**: 745 - j 5679 A

### 2.4 THE SOIL CHARACTERISTICS

Finally, detailed soil resistivity measurements at the substation site were carried out using the Wenner equal probe spacing technique (i.e., the distances between adjacent electrodes are equal). Table 2.1 gives the measured apparent resistance values at the substation site:

---

1 Note that typically, it is conservative to model a fault occurring on the phase furthest from the static wires, since this results in the lowest current pulled away from the substation grounding grid by means of magnetic field induction between the faulted phase and the static wires.
## Chapter 2. Description of the Problem & Definition of the System Data

<table>
<thead>
<tr>
<th>Separation Between Probes (feet)</th>
<th>Apparent Resistance (V/I) (ohms)</th>
<th>Depth of Current Probes (feet)</th>
<th>Depth of Potential Probes (feet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>152.300</td>
<td>0.3</td>
<td>0.2</td>
</tr>
<tr>
<td>3</td>
<td>48.160</td>
<td>0.3</td>
<td>0.2</td>
</tr>
<tr>
<td>6</td>
<td>6.120</td>
<td>0.3</td>
<td>0.2</td>
</tr>
<tr>
<td>15</td>
<td>3.340</td>
<td>0.3</td>
<td>0.2</td>
</tr>
<tr>
<td>20</td>
<td>1.760</td>
<td>0.5</td>
<td>0.2</td>
</tr>
<tr>
<td>30</td>
<td>1.110</td>
<td>0.5</td>
<td>0.2</td>
</tr>
<tr>
<td>50</td>
<td>0.692</td>
<td>1.0</td>
<td>0.2</td>
</tr>
<tr>
<td>75</td>
<td>0.441</td>
<td>1.0</td>
<td>0.2</td>
</tr>
<tr>
<td>100</td>
<td>0.320</td>
<td>1.0</td>
<td>0.2</td>
</tr>
<tr>
<td>150</td>
<td>0.218</td>
<td>2.0</td>
<td>0.3</td>
</tr>
<tr>
<td>200</td>
<td>0.156</td>
<td>2.0</td>
<td>0.3</td>
</tr>
<tr>
<td>300</td>
<td>0.106</td>
<td>2.0</td>
<td>0.3</td>
</tr>
<tr>
<td>400</td>
<td>0.079</td>
<td>3.0</td>
<td>0.3</td>
</tr>
<tr>
<td>500</td>
<td>0.064</td>
<td>3.0</td>
<td>0.3</td>
</tr>
</tbody>
</table>

Table 2.1 Measured Apparent Resistances of Substation Site Using the Wenner Method.
CHAPTER 3
SOIL RESISTIVITY INTERPRETATION USING RESAP

3.1 A HORIZONTAL TWO-LAYER SOIL MODEL

The following data values were entered as input to the RESAP soil resistivity analysis module of the CDEGS software package:

- **Apparent Resistance (V/I):** The apparent resistance measured at each probe spacing.
- **Cpin Depth:** The depth to which the current injection electrodes were driven into the earth. This value influences the interpretation of soil resistivities at short electrode spacings. It is an optional field data.
- **Ppin Depth:** The depth to which the potential probes were driven into the earth. This value also influences the interpretation of soil resistivities at short electrode spacings. It is an optional field data.
- **Spacing Between Probes:** The distance between adjacent measurement probes.

The soil resistivity interpretation module RESAP was used to determine equivalent horizontally layered soils based on the site measurements. Although RESAP is capable of producing multi-layered soil models, it is always preferable to try to fit the measured results to the simplest model (i.e., a two-layer model), at least initially. When a two-layer soil model is selected, the computations results lead to an equivalent two-layer soil structure as shown in Table 3.1. This table shows also grounding system impedances as computed by the low frequency grounding module MALT (see the next chapter). Note that the impedances shown here were computed for the initial design of the grounding system of the East Central Substation. The “RMS Error” in Column 5 of Table 3.1 (computed by RESAP as described in this section) provides a quantitative indication of the agreement between the measurements and the proposed soil models.

<table>
<thead>
<tr>
<th>Soil Model</th>
<th>Layer</th>
<th>Resistivity (Ω-m)</th>
<th>Thickness (Feet)</th>
<th>RMS Error (%)</th>
<th>Grid Impedance (Ω)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two-Layer</td>
<td>Top</td>
<td>308.38</td>
<td>1.94</td>
<td>15.17</td>
<td>0.507</td>
</tr>
<tr>
<td></td>
<td>Bottom</td>
<td>62.81</td>
<td>∞</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3.1 Horizontally Layered Soil Models Computed Using Data From Table 2.1.

The following sections describe the steps to achieve the soil model in Table 3.1.

3.2 PREPARATION OF THE RESISTIVITY INPUT FILE

The soil resistivity interpretation input file can be prepared by the interface modules provided, or with a standard text editor such as the one provided with CDEGS.
The following section describes the Windows compatible Toolbox input session, which is used to generate the computation input file (.F05 file extension) described in Printout A.1. This file can be reloaded during subsequent sessions. The most important features in preparing the data are explained in section 3.2.2.

3.2.1 Start up Procedures
In the SES Software <Version#> group folder, where <Version#> is the version number of the software, you should see the icons representing Autogrid Pro, AutoGroundDesign, CDEGS, Right-of-Way, SESEnviroPlus, SESShield-3D and SESTLC software packages, as well as four folders. The Documentation folder contains help documents for various utilities and software packages. The Program Folders provides shortcuts to programs, installation and projects folders. The System folder allows you to conveniently set up security keys. Various utilities can be found in the Tools folder. The main function of each software package and utility is described hereafter.

SOFTWARE PACKAGES

- **Autogrid Pro** provides a simple, integrated environment for carrying out detailed grounding studies. This package combines the computational powers of the computation modules RESAP, MALT and FCDIST with a simple, largely automated interface.

- **AutoGroundDesign** offers powerful and intelligent functions that help electrical engineers design safe grounding installations quickly and efficiently. The time devoted to design a safe and also cost-effective grounding grid is minimized by the use of automation techniques and appropriate databases. This module can help reduce considerably the time needed to complete a grounding design.

- **Right-of-Way** is a powerful integrated software package for the analysis of electromagnetic interference between electric power lines and adjacent installations such as pipelines and communication lines. It is especially designed to simplify and to automate the modeling of complex right-of-way configurations. The Right-of-Way interface runs the TRALIN and SPLITS computation modules and several other related components in the background.

- **SESEnviroPlus** is a sophisticated program that evaluates the environmental impact (radio interference, audible-noise, corona losses, and electromagnetic fields) of AC, DC or mixed transmission line systems.

- **SESShield-3D** is a powerful graphical program for the design and analysis of protective measures against lightning for substations and electrical networks. Its 3D graphical environment can be used to model accurately systems with complex geometries.

- **SESTLC** is a simplified analysis tool useful to quickly estimate the inductive and conductive electromagnetic interference levels on metallic utility paths such as pipelines and railways located close to electric lines (and not necessary parallel to them), as well as the magnetic and electric fields of arbitrary configurations of parallel transmission and distribution lines. It can also compute line parameters.

- **CorrCAD** tackles a large variety of cathodic protection design tasks and related issues, onshore and offshore, and can also predict the degree of corrosion control provided by a system. A typical application for corrosion control includes Impressed Cathodic Current Protection systems (ICCP) and use of sacrificial anodes in anodic protection systems, where anodic current is impressed on corroding material to enforce passivation. Another application is to estimate the effect of stray currents such as those produced by HVDC electrodes or dc rail traction systems on the corrosion of buried metallic structures. CorrCAD can evaluate the corrosion status of the structure and help optimize the location and characteristics of the corrosion protective system.
(such as ICCP) to minimize stray current interference effects on protected structures such as pipelines.

- **CDEGS** is a powerful set of integrated software tools designed to accurately analyze problems involving grounding, electromagnetic fields, electromagnetic interference including AC/DC interference mitigation studies and various aspects of cathodic protection and anode bed analysis with a global perspective, starting literally from the ground up. It consists of eight computation modules: RESAP, MALT, MALZ, SPLITs, TRALIN, HIFREQ, FCDIST and FFTSES. This is the primary interface used to enter data, run computations, and examine results for all software packages other than Right-of-Way, Autogrid Pro, AutoGroundDesign, SESTLC, SESShield-3D and SESEnviroPlus. This interface also provides access to the utilities listed below.

CDEGS is accessible via a modern, user-friendly and flexible main interface. A legacy interface, called CDEGS-Legacy, is also available.

**TOOLS**

- **AutoTransient** automates the process required to carry out a transient analysis with the HIFREQ and FFTSES modules.

- **CETU** simplifies the transfer of Right-of-Way and SPLITs output data to MALZ or HIFREQ. A typical application is the calculation of conductive interference levels in an AC interference study.

- **F05TextEditor** is an enhanced text editor that recognizes the command structure of the module indicated by the file prefix. The program provides syntax highlighting and a command parameter identification tooltip to greatly simplify manual editing of an .f05 file.

- **FFT21Data** extracts data directly from FFTSES’ output database files (file 21) in a spreadsheet-compatible format or in a format recognized by the SESPLOT utility.

- **GraRep** is a program that displays and prints graphics or text files. For more information on GraRep see Chapter 6 of the *Utilities Manual* or invoke the Windows Help item from the menu bar.

- **GRServer** is an advanced output processor which displays, plots, prints, and modifies configuration and computation results obtained during previous and current CDEGS sessions.

- **GRSplits** plots the circuit models entered in SPLITs or FCDIST input files. This program greatly simplifies the task of manipulating, visualizing and checking the components of a SPLITs or FCDIST circuit.

- **GRSplits-3D** is a powerful interactive 3D graphical environment that allows you to view and edit the circuit data contained in SPLITs input files and to simultaneously visualize the computation results.
RowCAD is a graphical user interface for the visualization and specification of the geometrical data of Right-of-Way projects. Its 3D graphical environment can be used to visualize, specify and edit the path data of Right-of-Way, and to define the electrical properties of those paths.

SESAmplitude computes the ampacity, the temperature rise or the minimum size of a bare buried conductor during a fault. It also computes the temperature of bare overhead conductors for a given current or the current corresponding to a given temperature, accounting for environmental conditions.

SESBat is a utility that allows you to submit several CDEGS computation module runs at once. The programs can be run with different JobIDs and from different Working Directories.

SESCAD is a CAD program which allows you to create, modify, and view complex grounding networks and aboveground metallic structures, in these dimensions. It is a graphical utility for the development of conductor networks in MALT, MALZ and HIFREQ.

SESConductorDatabase gives access to the SES Conductor Database. It allows you to view the electrical properties of conductors in the database, and to add new conductors to the database or modify their properties.

SESCrossSection provides an interactive interface with direct visual system representation for the specification of conductor characteristics and locations within a conductor path cross-section. The program allows data specification for eventual use in CorrCAD, Right-of-Way, Cable and Conductor modes of SESLibrary, SESeBundle, and Circuit, Group and Single modes of the TRALIN module.

SESCurveFit is a general curve fitting tool with a special focus on "Polarization curves" used in CorrCAD. It incorporates a curve digitizer utility as well.

SESeBundle finds the characteristics of an equivalent single conductor accurately representing a bundle of conductors, as far as their series impedance is concerned. This utility is particularly useful to simplify models in modules, such as HIFREQ, where reducing the number of conductors is important to keep the computational time low.

SESEnviroPlot is an intuitive Windows application that dynamically displays computation data produced by the SESEnviroPlus software module.

SESFcdist is an interactive and flexible interface to prepare and run input files, and view results from, the FCDIST computation module.

SESFFT is a Fast Fourier Transform computation module designed to help you automate time domain (lightning and switching surges) analyses based on frequency domain results obtained
from CDEGS computation modules such as SPLITS, MALZ, and HIFREQ. The forward and inverse Fast Fourier transformations, the sample selection of the frequency spectrum, and related reporting and plotting functions have been automated in SESFFT.

- **SESGSE** rapidly computes the ground resistances of simple grounding systems, such as ground rods, horizontal wires, plates, rings, etc., in uniform soils. SESGSE also estimates the required size of such grounding systems to achieve a given ground resistance.

- **SESImpedance** computes the internal impedance per unit length of long conductors of arbitrary geometry and composition, and whose cross-section does not vary over the length of the conductor. The program uses the Finite Element Method (FEM) for calculating the electrical characteristics of conductors and is capable of handling conductors of arbitrary shapes and realistic material properties. The calculations fully account for skin effect, and can be carried out at low or high frequency.

- **SESLibrary** allows you to inspect the properties of a large number of *components* that can be part of models for many SES Software computation modules. It currently includes a comprehensive database of conductors as well as several power cables.

- **SESPlot** provides simple plots from data read from a text file.

- **SESPlotViewer** is a tool used by **SESEnviroPlus** for plot rendering.

- **SESResap** is an interactive and flexible interface to prepare and run input files and view results from the RESAP computation module.

- **SESResultsViewer** processes the computation data and results of all computation modules in CDEGS, offering a complete solution for displaying the plots and reports in an integrated viewer. It presents a light layout with intuitive organization of its settings that use sensible defaults that, in turn, allow for a fast configuration of the settings in order to achieve the desired output results.

- **SESScript** is a script interpreter that adds programming capabilities to SES input files. SESScript can systematically generate hundreds of files from a single input file containing a mixture of the SIICL command language and scripting code and user-defined parameter ranges and increments.

- **SESShield** provides optimum solutions for the protection of transmission lines and substations against direct lightning strikes and optimizes the location and configuration of shield wires and masts in order to prevent the exposure of energized conductors, busses and equipment. It can also perform risk assessment calculations associated with lightning strikes on various structures.

- **SESSystemViewer** is a powerful 3D graphics rendition software that allows you to visualize the complete system including the entire network and surrounding soil structure. Furthermore, computation results are displayed right on the system components.

- **SESThreshold** is an application for computing threshold limits, as recommended by industry standards, for touch and step voltages. It is coupled with the Zone Editor application, allowing zones where different threshold limits are applicable to be defined.
➢ **SESTralin** is an interactive and flexible interface to prepare and run input files, and view results from, the TRALIN computation module.

➢ **SoilModelEditor** is a standalone module with an interactive graphical interface that assists in the creation of soils models for all relevant target SES modules.

➢ **SoilModelManager** is a software tool that automates the selection of soil model structures that apply during various seasons.

➢ **SoilTransfer** utility allows you to transfer the soil model found in several SES files into several MALT, MALZ or HIFREQ input (F05) files.

➢ **TransposIT** is a tool for the analysis of line transpositions on coupled electric power line circuits. To ensure that voltage unbalance is kept within predefined limits, it allows the user to determine the optimal number of power line transpositions and their required locations.

➢ **WMFPrint** displays and prints WMF files (Windows Metafiles) generated by CDEGS or any other software.

During this tutorial, for simplicity, we will be using the **Windows CDEGS** icon to carry out most of the input and output tasks. We will refer to the other utility modules when appropriate.

In the **SES Software** group folder, double-click the **CDEGS** icon to start the CDEGS program. You will get the CDEGS start-up window in Figure 3.1. There are three main elements in the start-up window: selection of the session mode of each module, definition of **Working Directory** and **Job ID**, and selection of the **Computation Modules**. Enter the complete path of your working directory in the **Working Directory** field (or use the **Browse** button to find the directory). Any character string can be used for the **Current Job ID**.

In the following session, we recommend the following **Working Directory** and **Current Job ID** as explained in Chapter 1:

**Working Directory:** C: (or D:)\CDEGS HowTo\Ground

**Current Job ID:** TUT1
If you intend to enter the data manually, proceed with this section, otherwise, follow the instructions in section 1.9 to copy the file “RS_TUT1.F05” to your working directory.

Click on the RESAP computation module and select ‘Specify’: the corresponding data entry screen will appear.
3.2.2 Data Entry

In the following section, it is assumed that the reader is entering the data as indicated in the instructions. Note that it is advisable to save your work regularly with the use of the Save icon at the quick access bar placed at the top of the RESAP workspace or by clicking the Save button from the Project tab in the project backstage. The entered data will be saved in an ASCII file named RS_TUT1.F05. This file can be retrieved at any time using the Open button in the Project Backstage. If a data entry session has to be interrupted, use Project | Exit to exit the program after saving your data.

As shown Figure A.1 in Appendix A, the RESAP commands are grouped into modules, reflecting the hierarchical nature of the SES Input Command Language. Each module of Figure A.1 (with the exception of the OPTION module) is associated to a button in the RESAP screen. The OPTION module is actually part of the RESAP main screen.

The Help Key (F1) can be used to obtain relevant context-sensitive information when any CDEGS Input or Output text field is selected.

The data entry field in the Module Description frame allows you to enter comments that will be used to describe the case to be analyzed in the RESAP module. They are shown in the RESAP output.

The data entry field in the Project Description frame allows you to enter comments that are shared by all of modules under a project. In this example, the project includes the RESAP, MALT and FCDIST modules.

If you place your mouse cursor on any comment line and click on it (i.e., focus on the comment line) then hit the F1 (Help Key) help text relevant to Comments text input area will be displayed.

A Run-ID SUBSTATION SITE #1 is entered in the Run-Identification data entry field (click the Specify radio button to define it) and the Imperial system of units is chosen. The run-id is useful in
identifying all the plots which will be made later in Section 3.4. Focusing on the Run-ID field and then hitting the F1 key will bring a help text related to that field.

Go to the Home tab and in the Measurements panel specify the method used to gather the data (select Wenner in the Method option, if not already selected). In the Traverse parameters frame, select the Apparent Resistance option as the Data type and enter the measured apparent resistances at the substation site (see Table 2.1). The Plots panel will also allow you to immediately inspect the results to determine the shape of the curve or the presence of noise in the measurements. The type of axis (linear or logarithmic) can be selected, as well as which quantity to plot (apparent resistance or apparent resistivity). The plot offers zooming capabilities and mouse-over tooltips appearing when clicking on data points that make it easy to read accurately the graph.

Now click on the Computations panel to specify the type of soil structure in which the grounding network is buried and to control the computation settings. Click the Soil Type panel to define the type of soil model you wish to use. Select the Horizontal Soil Layer option to instruct the program to best match the measured apparent resistances with this type of soil. The options under Number of Layers allow you to either explicitly request the number of layers for a horizontally layered soil type or to automatically determine the number of layers (Auto option, default). If the resistivity and thickness under Initial estimate for horizontal soil model parameters are left as blank (default setting), the program will determine suitable initial values for the requested soil characteristics.

By entering a 0 or blank value in all the applicable fields, you are asking the RESAP program to determine suitable initial values to the requested soil characteristics. If you prefer to specify your own values, you should enter valid initial estimates in all the required fields. In this way, the user can sometimes guide the program to a more satisfactory solution. In fact, using the Lock feature for
the Horizontally Layered soils, the user can force the program to conserve all selected layer resistivities and thickness of the layers in the computations and adjust all other layer parameters to obtain the best possible equivalent soil model. In this example, we are explicitly requesting a two-layer soil and we are allowing the program to vary the layer resistivity and thickness as shown below.

If you are not interested in learning more about fine-tuning RESAP computations, you should skip the rest of the section and move directly to Section 3.2.3. In general, the default computations selection is quite suitable in most cases. Otherwise, click the Computations buttons to bring up the Computations screen.

The Computation Options screen allows you to modify default control setting.

The Methodology option allows you to specify the minimization algorithms and to control the iterative minimization process. In this study, we use the Steepest method (which is the default). There are only three parameters you should modify when the RMS error between the computed data and measured data is not satisfactory. They are:

- **Accuracy**: This parameter sets the desired RMS error (default value is 0.025).
- **Iterations**: This parameter sets the total number of iterations (default value is 500).
- **Step Size**: This parameter specifies the minimum change of RMS error below, which the optimization process will stop. The program will conduct a convergence test by computing the average RMS error change over the past 25 iterations. The minimization will stop if the average RMS error change is less than the specified Step Size value. Decreasing the Step Size usually improves the fit of the computed soil model to the measured data, but increases the computation time. The default value of Step Size is 0.0001 (0.01%).

RESAP will terminate the iterative minimization process whenever the desired Accuracy is reached, or the minimization Step Size is smaller than the threshold value, or the total number of Iterations is
reached. More advanced optimization settings are available in the **Advanced options** screen. For additional information, you can consult the context-sensitive help by pressing the F1 key.

In the **Computation options** screen you can also define the extent of the **Computed Resistivity Traverse**. The **Computed Resistivity Traverse** option specifies a traverse along which apparent earth resistivities are to be computed based on the equivalent earth model determined by RESAP. Two values are to be entered:

1. The number of consecutive electrode spacings for which the computation of apparent resistivity is to be carried out. Note that the total number of computed points and field measurement points must not exceed 10,000 and that the default number of computed points is set at 100.

2. The incremental value of the outer-electrode spacing used for the apparent earth resistivity computations (meters or feet). This value represents the outer-electrode spacing increase between two consecutive computed points and is normally set at 1.

The **Advanced Options** screen allows you to modify default computation settings for the optimization process or generate different filters. By default, RESAP chooses **Automatic** filter, which is sufficient for most practical cases. The **High Precision** filter is sometimes needed when extreme soil conditions (very large soil resistivity contrast ratio) encountered and it will greatly increase the computation time. Generating new filters is seldom needed unless RESAP encounters a missing or corrupted filter database file.

Please note that the calculations start with a very short electrode spacing. The ratio of the outer-inner electrode spacing to the inner-inner electrode spacing will be based on the average ratio as determined from the field measurement data.

### 3.2.3 How to Produce the RESAP Input File

At this point, you have completed the preparation of the data using the RESAP interface: it is ready to be submitted to the RESAP computation module in the next section.

If you are a licensee of the CDEGS software you will now be able to proceed to Section 3.3. Users of the demo software are not able to process the input file, but are able to peruse all output files.
which are already available. Therefore read Section 3.3 for reference only. Any attempt to start the computation modules will result in a message stating that the Computation module is not active.

3.3 SUBMISSION OF THE RESAP RUN

You can either use RESAP screen or CDEGS Start-Up window to submit your RESAP run.

In RESAP screen, click on Compute button to invoke the RESAP module to perform the computations. After the processing completes, the F09 output file becomes available to display for examining the results via View Report (F09) button. In addition, the traditional CDEGS-Legacy Output Toolbox can however be invoked by Examine Button.

You can also use CDEGS Start-Up window to run the model. For this purpose, select the Compute option from RESAP module drop down. This does two things:

1. It saves a file under the name RS_TUT1.F05. The *.F05 files are ASCII files you can edit and view at any time.

2. It starts the RESAP computation program.

The RESAP program will start and will carry out all requested computations. The run should be quite fast (less than a minute). At completion, the program will produce three important files: an OUTPUT file (RS_TUT1.F09), a DATABASE file (RS_TUT1.F21) and a SHARE file (SF_TUT1.F11). These files are already in your working directory.

The OUTPUT file is an ASCII file, while the DATABASE and SHARE files are binary files. Any ERROR or WARNING messages generated during the RESAP run will be displayed during the computations and will also appear in the OUTPUT file. The SHARE file contains the computed soil model, which will be used later by the MALT module. You can view the OUTPUT file either by clicking the View F09 File button in the Computation Trace window or by clicking the File Viewer...
Chapter 3 Soil Resistivity Interpretation Using RESAP

( ) button in the Output section of the Tools tab. In the Text Viewer window, select the Soil Resistivity Analysis option and choose RS_TUT1.F09, click the OK button. You can also use the GraRep utility module to view the output file (See Section 3.2.1.1 and Section 3.4.1) by choosing File | Open option.

The next section examines the computation results using the Examine (Output) Mode of CDEGS RESAP module.

3.4 EXTRACTION OF RESAP COMPUTATION RESULTS

The OUTPUT file contains all the input information and computation results from your RESAP run. The DATABASE file is normally used by the Windows Toolbox and the SES Interactive Report & Plot Software (SIRPS) processors to display the computation results. In the following section, we will show you how to use the Windows Toolbox interface to produce the corresponding graphs.

If you have followed the instructions up to this point, the active JobID should be "TUT1". We will therefore extract the results and display the plot on screen. If you are in the RESAP screen, in the Computation Trace panel, click on Examine button or from the CDEGS Start-Up window click on RESAP module and select the Examine button. In both cases, the CDEGS-Legacy-Examine - RESAP screen will appear and you are now ready to make plots.

Enter a Plot Title “Substation Site #1” in order to identify the plot and click the Plot/Draw button. The above plot is created and displayed in the GraRep utility.

If you wish to save this plot into a file (.emf by default), you can click on the Save Plot button. Or you can save this plot directly in the GraRep under File | Save As... menu. In the GraRep window, you can also cut and paste this plot to any other softwares supporting .emf files such as WordPad, Word, Excel, CorelDraw, etc. Simply press “Ctrl + C” or select Copy Current Plot under the Edit menu to store the plot into the windows buffer.
The soil model table can be created by clicking the **Report** button in the **Examine - RESAP** screen. This table can also be saved into an ASCII file called *RESAP Report_TUT1.F17* into the Working Directory by clicking on the **Save Report** button in the **Examine – RESAP** screen.

You can print plots and reports displayed by the GraRep utility module directly to any Windows compatible printers simply by clicking on the print button 📣, or by selecting **Print…** from the **File** menu. You can visualize, shift, scale and add comments then print any plot by clicking the print preview button 📅.

Once you are done examining the results, click 🔄 in the toolbar to go back to the CDEGS-Legacy Start Up screen.
CHAPTER 4
COMPUTATION OF GROUND GRID PERFORMANCE USING MALT

In this chapter, the detailed computer model of the initial design of the East Central grounding system will be presented. We will show how to use the MALT computation module to determine the ground grid performance including touch voltages, step voltages and its ground resistance, which will be used for computing the fault current distribution in the next chapter.

4.1 PREPARATION OF THE MALT INPUT FILE

In this section the SESCAD program of the CDEGS software package will be used to create, modify, and view grounding networks and aboveground metallic structures *visually*, in three dimensions. The computation input file created by SESCAD, as described in this chapter, is shown in Printout A.2 in Appendix A. It can be reloaded during subsequent sessions. Also, you can use the specialized SESConverter tool to import and convert the CAD files of your grounding study to various SES software package compatible input files. SESConverter is strongly recommended if you need more flexibility in your CAD design. For more additional information please see Appendix B.

4.1.1 Start up Procedures

This step is identical to the one already described in Section 3.2.1. In the SES Software group folder, double-click the CDEGS icon to start the CDEGS program interface (if not already started). You will be prompted for a “Working Directory” and a "Current Job ID". Make sure that the proposed working directory is the same as the one used in the preceding chapter and enter TUT1 as the JobID.

From the Modules tab, select ‘Specify’ from the MALT drop-down menu and click the SESCAD button (see below) or select SESCAD under the Tools tab to start the SESCAD program.
Here, you can write a description of your current study in the space provided under Module description and select your desired system of units. Next, you are ready to input data in SESCAD as follows.
Chapter 4. Computation of Ground Grid Performance Using MALT

Creating MALT Input File

In order to share the soil model between RESAP and MALT program, the new MALT input file created in the SESCAD must be saved in the same Working Directory as that of RESAP and with the same JobID. In this tutorial, the proposed Working Directory is “\CDEGS HowTo\Ground” and the Job ID is “TUT1”.

In the following section, it is assumed that you are entering the data as indicated in the instructions. Note that it is advisable to save your work regularly using CTRL+S or Save Document under the File menu. This file can be retrieved at any time by clicking on Open Document… under the File menu, if a data entry session has to be interrupted, then resumed.

If you intend to enter the data in this example case yourself, then proceed directly to Section 4.1.2. If you do not wish to do so, follow the instructions in section 1.9 to copy the file “MT_TUT1.F05” to your working directory.

4.1.2   Data Entry

We will first define a Run ID and System of Units by selecting Define | Units and Other Settings… in SESCAD. In the Case Description block of this window, you can enter comment lines that are used to describe the case. They are echoed in the MALT output (.F09 file). In this tutorial, “SAFETY (TUT1)” is entered under the Specify option of Run ID, and the British (Imperial) Systems of Units is chosen. Note that a Run ID is different from the Job ID. The run-id is a string that is used to identify plots, such as those that will be made in Section 4.3, whereas the JobID is simply part of the file names.

In our initial design shown in Figure 2.2, we will require a 350 foot by 200 foot (107 m x 61 m) rectangular grid, having one corner at the origin of the x-y plane and buried at 1.5 feet (0.46 m) deep. Each conductor has a 0.017 foot radius (0.2 inches or 0.52 cm) and will be subdivided into 10 segments. The grid will be made of 9 equally spaced conductors along the X-axis and 7 equally spaced conductors along the Y-axis. The following paragraphs describe how to use the Create Object function in SESCAD to create this simple grid. If you have already loaded the data from the example file, you should see the grid shown in Figure 2.2.

From the Edit menu, select Create Object. Click on the Detailed Grid tab and enter the coordinates of three corners of the grid: a, b and c (as identified in the graphic display to the left of “Detailed Grid” title in the Create Object window).
Click on the **Characteristics** button to assign a radius of 0.017 ft to all conductors. Note that you can click on the button next to the radius field to expand a screen to show various conductor sizes and make a quick selection. By entering 10 under **Conductor Subdivision #**, the conductors are further subdivided (see next for more discussions). Click on the **Close** button to close the **Characteristics** window. Click on the **Apply** button. The grid is now created. Click on the **Close** button to close the **Create Object** window. You can click on the button (**Zoom to All Objects** under the **Display** menu) to zoom into the grid. You can also easily view the grounding grid by using the buttons indicated below.
Note that, for simplicity, we have defined in this example a grid with uniformly spaced conductors. However, in many cases, grids with uniformly spaced conductors are not as efficient as grids with conductors more closely spaced towards the edge of the grid than at its center, as will be demonstrated later in this tutorial.

The energization of the grid is defined by selecting Define | Network Energizations and Buried Structures... A nominal value of 1000 A is specified initially as all computed voltages and currents can be scaled proportionally once the true injection current has been determined with the FCDIST module.

One can control the required minimum total number of conductor segments by specifying this number in the field labeled “Desired Number of Segments for Main-Ground”. If this number is larger than the number of segments automatically generated by other segmentation processes, then MALT will break the largest remaining conductor segment in two until the desired number of segments is reached. Usually, you do not need to specify any segmentation values if you are dealing with a regular grounding grid because all conductors will, by default, be automatically segmented at each intersection point. This will normally generate enough conductor segments to accurately compute the non-uniform earth leakage current distribution in the grid. See the help item for Desired Number of Segments of Main-Ground (click in the field, then press the F1 key) for more details on conductor segmentation and when it should be specified.
Chapter 4. Computation of Ground Grid Performance Using MALT

At this point, we can optionally specify the soil model by selecting Define | Soil Model... under the Define menu. However, MALT will automatically use the results (if any) obtained from RESAP that were stored in the shared database file (SF_TUT1.F11). In this tutorial, RESAP provides a two-layer soil structure model. Note that you can also import a soil model that is in MALT input file (.F05 extension) by clicking on the Import button in the Soil Structure window.

Finally we need to define the observation points at which the software is to calculate earth surface potentials, touch voltages and step voltages in and around the substation. However, if you have already loaded the data from the example file, a set of computation profiles are already shown in the screen as dashed lines. You should avoid generating a duplicate set of profiles.

The observation points are defined to cover an area extending 10 feet outside the substation. We will define a profile containing evenly spaced points along the X-axis and replicate this profile along the Y-axis. This will result in a two-dimensional array of observation points at the surface of the earth above the grounding system.

To specify those points, first make sure to select the grounding grid, then select Generate Profiles under the Tools menu and enter the following parameters:

- **Border Offset**: Define points to extend 10 ft outside the grid
- **Distance between points**: 3.5 ft (1.07 m) (along the X-axis)
- **Distance between profiles**: 2.5 ft (0.76 m) (along the Y-axis)

*Note that the observation point increments (dX=3.5 feet along a profile and dY=2.5 feet between the profiles) are chosen so that the observation points land on the grid perimeter conductors, which are located 3.3 ft (1 m) outside the fence. This allows touch voltages with respect to the fence to be computed at the maximum distance away from the fence. If step voltages are found to exceed or be*
close to safety thresholds, it is recommended to set the spacing between observation points and profiles to 3.3 ft (1 m) outside the grids, in order to compute step voltages more accurately.

Click on the Save button (or select Save Document under the File menu) to save the MT_TUT1.F05 file. Users of the demo software are not able to save the file. This file is ready to be submitted to the MALT computation module in the next section.

If you are a licensee of the CDEGS software you will now be able to proceed to Section 4.2 and run MALT. Users of the demo software are not able to do so, but can look at the output files and create graphs and reports from the pre-run cases supplied on the SES software distribution media, as described in Section 4.3. Any attempt to start the computation modules will result in a message stating that the Computation module is not active.

### 4.2 SUBMISSION OF THE MALT RUN

There are two ways to submit the MALT runs.

#### 4.2.1 Submit Computation Program Using SESCAD

You can submit the run directly from SESCAD, by selecting the Run/Reports | Save & Run menu item. This will start the SESBatch program and automatically run the computation module. Note that for illustration purposes, the generic grounding grid shown in the following screen shot has been used instead of the specific case discussed in this How To manual.
Chapter 4. Computation of Ground Grid Performance Using MALT

Once the run is complete, a window will pop up to inform you that a log file has been generated. Click the OK button to close the message window. SESBatch allows you to conveniently access some of the important files that it generates. For example, from the Tools | View Run Log File… menu item you can view the log file generated during the computations. From the Tools | View Output File… menu item you can view the output file, which may contain ERROR or WARNING messages requiring your attention. Finally, you can launch Output Toolbox directly from the Tools | View Results with Output Toolbox… menu item.

4.2.2 Submit Computation Program Using CDEGS

In the CDEGS Start Up screen, select the Compute button under the MALT drop down menu to submit the MALT computation run. Make sure the Working Directory is \CDEGS\HowTo\Ground and the JobID is TUT1. Note that since you have already specified your model in the previous section, the MALT module’s left color bar is green, and therefore you can click the specify icon to modify the model or click the compute icon to launch the computation.

The MALT program will start and will carry out all requested computations. The run should be quite fast. After the model is computed, then both color bars under the MALT computation module button are green. You can click the Specify icon to modify the model, click the Compute icon to relaunch the computation or click the Examine icon to view/plot the results.

At completion, the program will produce three important files: an OUTPUT file (MT_TUT1.F09), a DATABASE file (MT_TUT1.F21) and the SHARE file (SF_TUT1.F11). These files are already in your working directory.

The OUTPUT file is an ASCII file, while the DATABASE file is a binary file. Any ERROR or WARNING messages generated during the MALT run will appear in the OUTPUT file. The SHARE file SF_TUT1.F11 now contains the soil model and the grid impedance computed by MALT. You can view the OUTPUT file either by clicking on the View F09 File button in the Computation Trace window or by clicking the (File Viewer) button under the Tools tab on the
Output section of the toolbar. In the Text Viewer window, select the Low Frequency Grounding radio button and choose MT_TUT1.F09, click the OK button. You can also use the GRAREP utility module to view this file.

4.3 EXTRACTION OF MALT COMPUTATION RESULTS

The OUTPUT file contains all the input information and computation results from the preceding MALT run.

The DATABASE file is normally used by the Windows Toolbox and the SES Interactive Report & Plot Software (SIRPS) processors (such as GRAREP) to display the computation results. In the following, we will show you how to use the SESResultsViewer (Section 4.3.1) to produce the corresponding graphs.

If you have followed the instructions up to this point, the active JobID should be “TUT1”. We will, therefore, extract the results and display plots on screen. From the CDEGS start up screen, select the MALT computation module and click the (Examine) button to examine the computation results. The SESResultsViewer screen will appear and you are now ready to make plots.

4.3.1 Obtain Ground Resistance

We will first plot top and 3D views of the grounding grid and we will select to display the axes. The following are the steps:

1. In the Data Selection panel, Select the Configuration radio button and click the Rendering button to access the configuration display options.
2. Select the Show-Axes option. Click the OK button to return to the SESResultsViewer screen.
3. In the Category drop down menu, select Conductor Data.
4. Make sure the Energization Scaling Factor value is 1 (otherwise check the energizing scaling factor option and enter 1).
5. In the Plot View drop down menu select the 3D option and click the Plot button.
6. In the Plot View drop down menu select the Top option and click the Plot button.

The two figures are generated in the Result Display panel, along with minimized picture buttons of the plots on the bottom. By clicking on these minimized buttons later in the session, these figures can be made the active plots again.
The resistance of the main-ground electrode can be obtained by clicking the Report button in the Data Selection panel. Scroll the window until you see the result. The ground resistance is 0.507 Ω.
4.3.2 Plot Scalar Potentials and Touch Voltages

Select the Computations radio button in Data Selection panel to examine plot results in percent of the reference GPR (Ground Potential Rise). This is quite appropriate since we are plotting these results before determining the actual current discharged by the grounding system. The following are the steps:

1. Select Scalar Potentials from the drop-down menu under the Category option to plot the earth surface potentials.
2. Select Scalar Potentials from the Result Selection drop down list.
3. Select the Percent of Reference GPR option from the Display Format drop down list.
4. Select the 3D Perspective option from the Plot View drop down.
5. Click the Rendering button to access the setup screen for the display options. Select the 3D-Perspective in the Plot View drop down menu (if not yet selected). In the Axes-Limits option, select the User-defined and enter the indicated numbers to customize the scaling of the axes.
6. Click the OK button to return to the SESResultsViewer main screen. Click the Plot button and the scalar potential in percentage of the grid GPR is produced.
7. Select Touch Voltages from the drop-down list in the Result Selection option to plot the touch voltages. Select the 3D Perspective from the Plot View option. Click the Plot button. The touch voltages in percentage of the grid GPR are produced.
You may wish to repeat this process after checking the **Interpolate Computed Curves** check box in the **Computations Display Options** screen and setting the number of curves to 1 or 2. Select the **3D-Perspective** in the **Plot View** option (if not yet selected). In the **Axes-Limits** drop down menu, select the **Automatic** option.

### 4.3.3 Plot Leakage Currents

Next, we will display earth leakage currents in a portion of the grid, namely the lower left corner.

1. Click the **Configuration** radio button, select **Currents and GPRs** from the **Category** option, select **Leakage Currents of Conductor Segments** from the **Result Selection** options and select **Top** from **Plot View** option.
2. Select the **Conductor Filters** button. In **Configuration-Conductors Filters and Search Area** screen, go to **Search Area** tab and select the **Use Search Area** option. Next, add 4
search area vertices and enter the coordinates shown in the ZOOM grid in the following screen.

3. Click the **Rendering** button. In the **Configuration Display Options** screen, deselect the **Show-Axes** option, then click **OK** to return to the **SESResultsViewer** screen.

4. Click the **Plot** button.

The screen below displays a top view of the grid, with numbered arrows representing the leakage current from each conductor segment. Please note, however, that the current leakage values indicated on the plot have not yet been adjusted according to the current distribution computed by FCDIST and, consequently, should not be used in your final analysis. It is provided here only to illustrate the effects of the current distribution calculations on the MALT results. The final leakage currents will be requested again later in Chapter 6.
CHAPTER 5

FAULT CURRENT DISTRIBUTION ANALYSIS USING FCDIST

5.1 INTRODUCTION

The touch and step voltages associated with the grounding network are directly proportional to the magnitude of the fault current component discharged directly into the soil by the grounding network. It is therefore important to determine how much of the fault current returns to remote sources via the skywires and neutral wires of the transmission lines and distribution lines connected to the East Central Substation. In other words, the current discharged into the East Central Substation grounding system is smaller than the maximum available fault current, because a portion of the fault current returns via the skywires and neutral wires of the power lines connected to the East Central Substation. In order to be able to determine the actual fault current split, a model of the overhead transmission line network must be built. Before this, however, it is necessary to calculate transmission and distribution line parameters such as self and mutual inductive and capacitive impedances, at representative locations.

This work is described in the present chapter. In this study, we assume a single-phase-to-ground fault. The computation module FCDIST was used to compute the fault current distribution. For more complicated fault scenarios, the computation modules TRALIN and SPLITS are combined to complete the task: the line parameters are computed using the TRALIN module of the CDEGS software package, then the resulting parameters are used by the SPLITS module of the CDEGS software package to compute the fault current distribution. Chapter 5 of the How To… Engineering Guide entitled “Large Suburban Substation Grounding System Analysis: Measurements & Computer Modeling” gives a detailed example about how to use TRALIN and SPLITS to compute the fault current distribution. As compared with the TRALIN/SPLITS circuit solver, the FCDIST module is much simpler. It allows you to quickly estimate the fault current distribution at a substation. To minimize modeling time, there are certain restrictions in the FCDIST module: (a) the fault must be at the Central Site (substation under study); (b) all tower impedances must be the same between the Central Site and any given Terminal (power source); (c) one average soil resistivity is used throughout the entire region covering the Central Site and the Terminals; (d) the system configuration must be strictly radial (i.e., no taps or loops). None of these restrictions apply to the TRALIN/SPLITS circuit solver.

In the FCDIST computer model, only the faulted phase and neutral conductors (shield wires) are represented. The locations of the faulted phase wire and the neutral wires are specified in terms of their Cartesian coordinates. The characteristics of the faulted phase wire need not be considered as its current is specified. FCDIST computes the self impedances of the neutral wires as well as the mutual impedances between the phase and neutral wires. The fault current distribution is then obtained. For a single-phase-to-ground fault, if the faulted phase contains a bundle of several conductors, the location of the faulted phase can be chosen to be at the geometrical center of the phase bundle. When significant currents flow in the non-faulted phases, the vector sum of the
currents flowing in the three phases of the circuit of interest is specified as the current flowing in the equivalent faulted phase. You will note that the primary purpose of the FCDIST run is to determine the distribution of the fault current between the ground wires and the grounding system at the fault location. This run will also determine the magnitude of the current that returns to the power source via the terminal grounds and determine the influence of the mutual impedances between phase and ground wires. This latter effect manifests itself as a “trapped” current in the ground wires.

5.2 PREPARATION OF THE FCDIST INPUT FILE

Similar to RESAP and MALT, you can prepare the FCDIST input file using several input interface modules as well as your favorite text editor (or the one provided with CDEGS). The following section describes the Windows-compatible Toolbox input session. The most important features in preparing the data are explained in Section 5.2.2.

5.2.1 Start up Procedures

This step is identical to the one already described in section 3.2.1. In the SES Software group folder, double-click the CDEGS icon to start the CDEGS program interface (if not already started). You will be prompted for a “JobID”. Be sure that the working directory is the one used for RESAP and MALT. Enter TUT1 as the JobID. Then, click OK. Note that if you choose a JobID different from TUT1, the data transfer between RESAP, MALT and FCDIST will not be available.

From the Modules tab select FCDIST and Select ‘Specify’. The following FCDIST screen will appear and you are now ready to input your data. As can be seen, both color bars under FCDIST module in CDEGS screen are red, indicating that the model has not been created yet.

In the following section, it is assumed that the reader is entering the data as indicated in the instructions. Note that it is advisable to save your work regularly with the File | Save Session Input File command (in the File menu) or by clicking the Save Session button in the FCDIST main screen. The data entered up to that point will be saved in an ASCII file called FC_TUT1.F05.

If you intend to enter the data manually, proceed directly to Section 5.2.2. If you do not wish to do so, follow the instructions in section 1.9 to
copy the file “FC_TUT1.F05” to your working directory.

5.2.2 Data Entry

As shown in Figure A.3, the FCDIST commands are grouped into modules, reflecting the hierarchical nature of the SES Input Command Language. Each module of Figure A.3 (with the exception of the OPTION module) is associated to a button in the FCDIST screen. The OPTION module is actually part of the FCDIST main screen.

An average soil resistivity of 100 Ω-m and a frequency of 60 Hz are entered although these two values are the default values and need not be indicated. They will be used for the computation of the transmission line neutral conductor self and mutual impedances. Note that the average soil resistivity is an average soil resistivity between the East Central and the other three power sources (Greenbay, Hudson and Newhaven). For horizontally layered soils, only the resistivity of the bottom layer should be considered due to its infinite extent.

Edit Comments button allows you to type comment lines that are used to describe the case being analyzed. They are echoed in the FCDIST output file. Also, The British System of Units is chosen along with inches as units for entering radii.

We will name the substation East Central but we do not need to indicate the grid impedance values since FCDIST will extract this information from the shared data file by selecting the Use Shared Data (MALT) option. The next step is to define the three transmission lines that enter the central site. We will enter the required data in the Electric Network Specification section.

Now we are ready to specify the overhead transmission line
system. First, click the Add Terminal button, and enter GREENBAY as the name of your first terminal. Next, select Configuration Method radio button and click on Overhead Transmission Line (or DL) with 2 Shield Wires from the Type of Terminal drop down menu. Note that there are two methods to define the characteristics of neutral conductors and mutual impedance between the faulted phase and the neutral conductors. By default, the Configuration Method is selected here, in which these parameters are computed based on the locations of the faulted phase and neutral wires.

Now click on Edit Terminal button to specify the overhead transmission line system of the GREENBAY terminal. A graphical layout of the system will be shown in Editing Terminal screen. In this screen, all the data fields are required to be filled to model the GREENBAY terminal. First, in the Terminal Ground Impedance section, insert the ground impedance value (i.e. 0.2 \( \Omega \)). In the Fault Current section, enter current flowing in the phase wire (i.e., 1225.88 - j5013.0 A). The neutral connections including the source-to-neutral connection impedance of the shield (or overhead ground or neutral) wire and the phase-to-shield-wire mutual impedance at the source both are typically equal to zero. The section or Span Length to enter is 1056 feet. The number of sections or spans in the power line is 65 as indicated in Figure 2.4 and therefore the Total Line Length is 68640 feet. The tower impedance value is 10.0 \( \Omega \).

What is left is to define the locations of the faulted phase and both neutral wires. As mentioned in Chapter 2, we assume that the highest fault current discharged by the East Central grounding grid occurs for a 230 kV single-phase-to-ground fault at the East Central Substation on Phase A of Circuit 2. The phase A is located at the height of 92.5 feet above ground and it is 16.5 feet away from the center of the transmission line. The neutral conductors are considered to be a pair of bundled conductors with the bundle center 115 feet (35.05 m) high, at the center-line of the transmission line tower. As shown in Figure 2.3, the radius of the neutral bundle is half the distance between the neutral wires, i.e., 24 feet (7.31 m). The characteristics of the neutral conductors in terms of internal reactance, internal resistance, and radius of the conductors in the neutral bundle can be imported easily from the built in conductor databases simply by clicking the Import from DB… button and selecting the appropriate conductor class and conductor type (i.e., 7 no.8 Alumoweld in the database). Click the OK button to save those values and return to the preceding screen.
We will now enter the remaining two terminals. Click the **Add Terminal** button, and enter **HUDSON** as the name of your second terminal. Enter the data displayed in the screenshot below.

Finally, we will now enter the last terminal. Click on the **Add Terminal** button, and enter **NEWHAVEN** as the name of your third terminal. Enter the data displayed in the following partial screen.
You can now return to the FCDIST main screen by clicking OK.

### 5.2.3 How to Produce the FCDIST Input File

At this point, you have completed the preparation of the data using the FCDIST: it is ready to be submitted to the MALT computation module in the next section.

If you are a licensee of the CDEGS software you will now be able to proceed to Section 5.3. Users of the demo software are not able to process the input file, but are able to peruse all output files which are already available. Therefore read Section 5.3 for reference only. Any attempt to start the computation modules will result in a message stating that the module is not active.

### 5.3 SUBMISSION OF THE FCDIST RUN

You can either use the FCDIST interface or the CDEGS main screen to submit the FCDIST run to the MALT computation module. The computation process through the CDEGS main screen is quite similar to what we have done before in chapter 4, and can be performed by clicking the Compute button under the FCDIST computation module.

In the FCDIST screen, once you inserted all the required data, you can simply click on Process button to submit the FCDIST run. This does two things:

1. It saves a file under the name FC_TUT1.F05. Each file can be reread from the File | Open Input File command (in the File menu).

2. It starts the FCDIST computation program as shown below.
Chapter 5. Fault Current Distribution Analysis Using FCDIST

The FCDIST program will start and will carry out all requested computations. The run should be quite fast. At completion, the program will produce three important files: an OUTPUT file (FC_TUT1.F09), a DATABASE file (FC_TUT1.F21) and the SHARE file (SF_TUT1.F11). These files are already in your working directory.

The OUTPUT file is an ASCII file, while the DATABASE and SHARE files are binary files. Any ERROR or WARNING messages generated during the FCDIST run will appear in the OUTPUT file. The computed actual fault current is saved in the SHARE file. You can view the OUTPUT file FC_TUT1.F09 by clicking the View Computation Summary button. You can also use the GRAREP utility module to view this file. The actual fault current is written in the SHARE file.

5.4 EXTRACTION OF THE FCDIST COMPUTATION RESULTS

The OUTPUT file contains all the input information and computation results from your FCDIST run.

The DATABASE file is normally used by the Windows Toolbox and the SES Interactive Report & Plot Software (SIRPS) processors to display the computation results. In the following, we will give an example to show how to use the Windows Toolbox interface to produce the corresponding graphs.

If you have followed the instructions up to this point, the active JobID should be "TUT1". We will therefore extract the results and display the plots on screen. On FCDIST main screen click on the View Plots and Reports button and select the Using Output Toolbox radio button to plot the computation results. Note that
you could also use the CDEGS main screen to evaluate the FCDIST results by clicking the Examine button under FCDIST computation module.

We will first plot currents on the shield wires:

1. In the Determine option, click the Section Current radio button. In the Type of Axes option, select the Magnitude radio button.
2. In the Terminal option, select the One Terminal Plot and enter 1 in the Terminal Number field, 1 in the Beginning Section field and 100 in the Ending Section field.
3. Lastly, enter 10 in the Threshold data entry field. Click the Plot/Draw button.

The values just entered will instruct the program to plot the current in every section (or span) of the neutral wire for Section 1 to 100 of Terminal 1 and to report all values exceeding 10 A. Please note that 100 does exceed the number of sections defined in the input data (i.e., 65 sections). However, the program automatically selects the highest section number in this case.

The plot shows that a considerable portion of the fault current (about 3000 A) leaves the fault site via the overhead ground wires. This current, however, quickly flows into the earth via the first few towers and then levels off to a constant “trapped” current maintained by induction from the faulted phase.

We will now plot the shunt or tower structure potentials by clicking the Shunt Potential radio button in the Determine option and by clicking the Plot/Draw button. The plot displayed shows the resultant transmission line tower potentials as a function of section number, beginning at the central site. Again, we see that the values drop off quite abruptly and then increase again as the terminal station is approached.

Click the Report button to display all important currents computed by FCDIST. These are displayed here in a summarized format. The magnitude of the total earth current (i.e., 9334.9 A) can be used to scale the results obtained from the MALT simulation, which was based on a grounding system current of 1 kA, to obtain the actual GPR, touch and step voltages associated with the substation grounding system.
Finally, you will find below a partial printout from the FCDIST output file FC_TUT1.F09 (towards the end of the file), which shows some of the useful results we requested.

```
CURRENT SPLIT AT CENTRAL SITE

<table>
<thead>
<tr>
<th>TERMINAL</th>
<th>ACTIVE</th>
<th>REACTIVE</th>
<th>ACTIVE</th>
<th>REACTIVE</th>
<th>ACTIVE</th>
<th>REACTIVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>GREENBAY</td>
<td>1225.9</td>
<td>-5813.0</td>
<td>588.48</td>
<td>-2919.7</td>
<td>649.40</td>
<td>-2033.3</td>
</tr>
<tr>
<td>HUDSON</td>
<td>722.02</td>
<td>-6452.6</td>
<td>998.19</td>
<td>-2534.5</td>
<td>276.17</td>
<td>-3918.1</td>
</tr>
<tr>
<td>NEWHAVEN</td>
<td>744.90</td>
<td>-5678.8</td>
<td>881.95</td>
<td>-2358.2</td>
<td>137.05</td>
<td>-320.6</td>
</tr>
<tr>
<td>TOTAL</td>
<td>2692.8</td>
<td>-17144.4</td>
<td>2460.6</td>
<td>-7812.4</td>
<td>232.19</td>
<td>-9332.0</td>
</tr>
</tbody>
</table>
```

This partial printout also indicates that of the total fault current of 2692.8 -j 17144 A, only 232.19-j 9332.0 A flows into the earth via the grounding system of the East Central Substation.

Once you are done examining the results, click in the toolbar to go back to the CDEGS-Legacy Start Up screen.
CHAPTER 6

PERFORMANCE EVALUATION OF EAST CENTRAL SUBSTATION

Now that we have determined the soil structure, grounding system performance and fault current magnitude and distribution, we are ready to evaluate if our proposed design is safe and adequate. In this chapter, we will demonstrate how to extract the computation results taking into consideration the actual fault currents stored in the shared database file. We will describe the detailed steps that were taken to compute touch voltages, grounding grid potentials, and longitudinal currents throughout the East Central Substation, in order to determine at what locations, if any, mitigative measures are required. Note that this step cannot be completed until the FCDIST computation module is run. Once FCDIST is run, the actual resistance of the grounding grid as calculated by MALT is used and FCDIST computes the distribution of the fault current between the grounding system at the East Central Substation and the incoming transmission line shield wires. Of course, a user can at any time override the automatic transfer of data from one module to the other by specifying explicitly in the input fields the values of the transferred/shared data.

6.1 SAFETY CRITERIA

Before describing the steps to extract the computation results, let us first identify the safety objectives.

One of the main concerns when designing grounding systems is to ensure that no electrical hazards exist outside or within the substation during normal and fault conditions. In most cases, there are no safety concerns during steady-state normal conditions because very little current flows in the neutral and grounding system. This current, called residual current, exceeds rarely 10% of the nominal load current in most electrical distribution systems. Therefore, safety is usually a concern only during phase-to-ground faults.

In practice, most electric substations are fenced and the fence is quite often placed 1 m (3.28 ft) inside the outer conductor loop of the grounding system. This way, a person contacting the fence from the outside will be standing above or close to a ground conductor which will normally result in lower touch voltages than in the case where the fence is not surrounded by such a ground conductor loop. In this study, the fence at the East Central Substation is located 1 m inside the outer loop of the grounding system. Furthermore a large portion of the fence is not metallic (concrete or bricks).

Therefore, unless there are concerns for transferred potentials to remote locations via overhead or metallic paths, such as gas, oil or water pipes, railway tracks, etc., only the area delimited by the grounding system outer loop conductor needs to be examined with respect to unsafe touch voltages. However, step voltages must be explored everywhere inside and outside the substation site. In general, however, step voltages are rarely a concern at electric power substations.
6.1.1 Touch Voltages

The first safety criterion used for the evaluation of the grounding system performance is the touch voltage limit. The touch voltage is usually defined as the difference in potential between a point on the earth’s surface, where a person is standing, and an exposed conductive surface within reach of that person.

ANSI/IEEE Standard 80-2000 (and IEC 479-1) provides a methodology for determining maximum acceptable touch voltages, based on the minimum current required to induce ventricular fibrillation in a human subject. The touch voltage limit is a function of shock duration (i.e., fault clearing time), system characteristics (for short fault clearing times), body weight, and foot contact resistance (which depends on the electrical resistivity of the material, such as crushed rock or soil, on which the person is standing). The table below shows how the touch voltage varies as a function of earth surface covering material, for a 0.3 s fault clearing time, a system X/R ratio of 20, and a 50 kg body weight.

<table>
<thead>
<tr>
<th>Surface Layer</th>
<th>Touch Voltage Limit (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Resistivity (Ω-m)</td>
</tr>
<tr>
<td>Native Soil</td>
<td>308.38</td>
</tr>
<tr>
<td>6&quot; Crushed Rock</td>
<td>3000</td>
</tr>
</tbody>
</table>

The crushed rock surface layer installed on the surface of the East Central Substation is 6" (0.15 m) thick and has an estimated resistivity (when wet) of 3000 Ω-m. The maximum clearing time of the backup relays is assumed to be 0.3 s. The crushed rock surface layer overlies a soil with a resistivity of 308.38 Ω-m. Resistivity varies as a function of the type of rock, the size of the stones, the moisture content and the degree of contamination (e.g., filling of the voids between stones by finer lower resistivity material). The above table and similar ones can be produced, printed on exported by clicking the Use Safety Limits button as explained in section 6.1.4.

6.1.2 Step Voltages

A similar table can be compiled for step voltages, defined as the difference in potential between two earth surface points spaced 1 m (3.28 ft) apart.

<table>
<thead>
<tr>
<th>Surface Layer</th>
<th>Step Voltage Limit (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Resistivity (Ω-m)</td>
</tr>
<tr>
<td>Native Soil</td>
<td>308.38</td>
</tr>
<tr>
<td>6&quot; Crushed Rock</td>
<td>3000</td>
</tr>
</tbody>
</table>

Within a substation and within 1 m (3.28 ft) outside the perimeter fence, step voltages are lower than touch voltages; furthermore, the maximum acceptable values are higher than for touch voltages. Consequently, satisfying the touch voltage safety criteria in this area automatically ensures satisfaction of the step voltage safety criteria. The step voltages in the substation and in an area extending 10 ft (3.05 m) outside the substation will be examined. Outside the extended area of the
substation, no computations were performed. However, it is unlikely for hazardous step voltages to exist at such remote locations when they are safe closer to the substation.

### 6.1.3 GPR Differentials

Significant potential differences between distant parts of the grounding system can give rise to local touch voltages or equipment stress voltages when low voltage insulated conductors connect equipment at two such locations. Appropriate protection must be in place at such locations, rated for the GPR differentials that can arise. The GPR differentials are not going to be a concern in this study since the grounding grid is small. If the grid is extensive or if there are buried metallic structures connected to the grounding system, the GPR differentials should be examined using the MALZ or HIFREQ Computation Modules.

### 6.1.4 Determining Safe Touch and Step Voltages Criteria

The safe touch and step voltages can be estimated easily using the SESThreshold tool. The only requirement is that you must have a finished MALT (or MALZ) run so that SESThreshold can be invoked. In this case, we choose the MALT run (MT_TUT1.F21), which was finished earlier.

If you followed the tutorial up to this point, your current JobID should be TUT1.

Click on the MALT computation module button on CDEGS main screen and select the ‘Examine’ button to make a safety analysis. The SESResultsViewer screen will be appear and you are ready to access the Safety screen.

On the Data Selection panel, select Computations radio button (if not yet selected). From the Category drop down menu select the Scalar Potentials option, and then in the Define Safety Threshold frame select the Specify in Threshold Module option as the input mode.

By default, the safety limits for touch and step voltage (shown as 398.2154 V for touch voltage, and 1088.9149 V for step voltage) are computed based on a native soil (308.38 Ω-m resistivity in this case) with a crushed rock layer surface with a thickness of 0.5 m and resistivity of 1000 Ω-m for a fault duration of 0.5 s.

The crushed rock layer installed on the surface of the East Central Substation is also 6” (0.15 m) thick and has an estimated resistivity (when wet) of 3000 Ω-m. The backup fault clearing time is 0.3 s.

To make a further safety analysis, click on the browse button to invoke the SESThreshold tool. In the Threshold Editor screen, in Network Specification panel enter 0.3 seconds for the Shock Duration. From Zone Specification panel, in the Surface Layer section enter 3000 Ohm-m for the surface resistivity and enter 0.1524 m (6 inch) for its thickness. Note that you can easily pick a
different safety scenario by selecting the desired values for system frequency, shock duration, X/R ratio, different standards and calculation methods, surface layer resistivities and soil models. Also, from the Human Data tab in Zone Specification panel you have the option to define a calculation method for body current threshold and resistance. Press the F1 key for further details about the safety calculations.

Next, select the Step option from Threshold Editor for drop down menu, and insert the required data to compute the safety for step voltages as shown below.
Once you entered all the required data, click **OK** in the **Threshold Editor** screen to return to the **SESResultsViewer** screen. This will generate a safety report (TH_TUT1_ThresholdReport) in the working directory `\CDEGS HowTo\Ground`. This report indicates that touch voltages of 936.6 V or less and step voltages of 3160.8 V or less are safe if a 6" (0.15 m) layer of crushed rock of 3000 Ω-m is overlying a native soil with a resistivity of 308.38 Ω-m. These values are also shown directly on the **SESResultsViewer** screen in **Plotting Threshold** data field.

To find out the safety limits that apply at distances larger than 1 m from the fence (where no crushed rock is installed), you can simply set the surface layer resistivity and thickness to zero. This shows that touch voltages of 289.3 V or less and step voltages of 571.5 V or less are safe if no surface crushed rock is present at East Central Substation.
6.2 GROUND POTENTIAL RISE, TOUCH AND STEP VOLTAGES

6.2.1 Examine GPR and Touch Voltages

We will now examine the main computation results performed by MALT taking into consideration the actual current discharged by the grounding system. In the SESResultsViewer, click the Computations radio button. Click the Report button and a brief report (see below) appears on the Result Display window. This report indicates that the "Total Current Flowing in Main Electrode" is 9334.9 A, therefore the current scaling factor for the input current of 1000 A is 9.3349. Note that this value will be used as an Energization Scaling Factor in the future plots. Also, the GPR is 4732.4 volts, a value that is not considered excessive in most cases involving grounding of electric power substations.

![SESResultsViewer screenshot]

Next, we examine the scalar potential and touch voltages by repeating the steps described in Section 4.3.1. We will now use Volts as the Display Format (default setting) and 3D-Prespective as the Plot View. Click the Plot button. The following 3D perspective view of the earth surface potentials appears on the screen. This plot indicates that earth potentials exceed 4000 V above the ground conductors within the substation while they fall sharply below 2000 V a few feet outside.
The next step is to examine the touch voltages in the substation. Because we are only concerned with the touch voltages in the substation, while the observation points are defined to cover an area larger than the area occupied by the substation (mainly to examine the step voltages), the zoom feature will be used. Select the Touch Voltages item from the Result Selection combo drop list. On the Computations setting section, click the More button, insert 9.84 feet as a Search Radius for Reference GPR and click on the Observation Points and Profiles Filters button. In the prompted window, check the Use Search Area box. Add 4 vertices and fill in the various fields as shown below in the Search Area Vertices screen. This step specifies a zoom area limited by the grounding system outer loop. Note that the coordinates are chosen such that the zoom area is slightly bigger than the area limited by the grounding system outer loop to include the outer loop conductors. Click OK to return to the SESResultsViewer screen.
Chapter 6. Performance Evaluation of East Central Substation

Click on the Plot button: a 3D perspective plot of the touch voltages in the substation is displayed. You will note that the highest touch voltages that occur on the corner meshes of the grid seem to be on the order of 2500 V. Select the 2D option from the Plot View drop down and click the Plot button. A 2D plot of the touch voltages appears.

This 2D plot allows us to read easily the magnitude of the maximum corner touch voltages from the Y-axis (about 2500 V). Another useful plot view is the 2D color spot. Select the Spot 2D option from the Plot View drop down list. Click on Rendering button to bring up the Computations Display Options and check the Superpose Grid and Preserve Geometry Proportion boxes (if not yet selected). Make sure that the Spot-Fill Combo shows the Color Fill item as shown in the screen. Note that the Linear and Automatic options are chosen by default for Display Color Level and Number of Levels, respectively. With these options, a 2D-Spot plot will be produced using 10 standard colors/levels. However, you can customize the number of colors/levels by selecting the User-Defined option. For now we will produce a 2D-Spot plot using the Automatic option. Click the OK button on the Computations Display Option screen to return to the SESResultsViewer screen, then click on the Plot button to get the following color 2D spot plot which indicates that the highest touch voltage is 2234.2 V. Based on the Safety report, it is clear, that at most locations the actual touch voltages of the East Central Substation grounding system exceed the safe values (936.6 V for 0.3 s based on IEEE Standard #80 Safety Assessment).
The exact locations \((x, y, z)\) where the touch voltages are unsafe can be shown in a *.csv file. This feature allows you to find out the highest and lowest touch voltages in a region. In Data Selection panel, click the Export button and check the Report Maximum or Minimum Values option in the Data Selection frame. The highest and lowest touch voltages found within the zoom area can be exported in the report file (*.csv extension). Select either Report Maximum Values or Report Minimum Values from the Reported values drop down. The number 5 in the Reported Values field
instruct the program to save the 5 highest or lowest touch voltages found within the zoom area. Click the **Proceed** button. These data are saved in the report file (MT_TUT1_Computation_Scalar Potentials.csv).

6.2.2 **Examine Step Voltages**

The values of the step voltages everywhere within the substation and 10 feet (3.05 m) outside the substation can be displayed using similar plot views as for the touch voltages. The following are the steps:

1. Select the **Step Voltages (Spherical)** option from the **Result Selection** drop-down list and select **Spot-2D** from the **Plot View** option.
2. Select the **User-Defined Value** option as the input mode in the **Define Safety Threshold** frame.
3. Make sure that the **Use Search Area** box in the **Observation Points and Profile Filters** screen is de-selected.
4. Click on the **Plot** button.

The plot shows clearly that the step voltages everywhere do not exceed 565.81 V, a value less than the maximum safe step voltage 571.5 V shown earlier.

It is important to mention that computations of step voltages are sensitive to the location of observation points. When the maximum computed step voltage is on the border line as compared with the safe step voltage limit (566 V vs. 572 V for native soil in this case), it is recommended to reduce the spacing between observation points.
to less than 1 m in order to capture the worst case step voltage which are usually at the corners of a substation where earth potentials drop quickly.

### 6.2.3 Examine Leakage Currents

Finally, we will repeat the steps made earlier to plot the leakage currents in a portion of the grid, namely the lower left corner to demonstrate the change that took place once the actual current distribution was computed by FCDIST. The following are the steps:

1. Click the Configuration radio button. Select the Leakage Currents of Conductor Segments option from the Result Section drop-down list.
2. Click on Conductor Filters button and in the Search Area tab, check the Use Search Area box and enter the coordinates in the grid as shown below.
3. Select Top from the Plot View option and click the Plot button.

![Image of FCDIST interface](image)

This plot displays actual leakage currents being dissipated by the grounding system at East Central substation. Compare this plot with the equivalent one plotted in Chapter 4 before FCDIST was run.
CHAPTER 7

REINFORCING THE GROUNDING SYSTEM

The touch voltages obtained in Chapter 6 indicate that our initial design is quite far away from providing a safe ground grid design. The touch voltages exceed the safe value at most locations of the substation. The highest values occur in the corner meshes of the grounding grid, which suggests that there is a need to have more conductors towards the edge of the grounding system and less in the central portion. This observation is consistent with analytical and experimental evidence. However, the optimum or most efficient conductor compaction at the periphery of a grounding system depends on many factors, particularly on earth structure characteristics. Moreover, practical considerations often introduce additional constraints, which must be accounted for. In general, however, the following crude rule of thumbs can be used as a preliminary set of guidelines:

- When the surface (shallow depth) soil resistivity is small compared to the deeper layers (those which are not in contact with the grounding system), use grids with more conductors at the edge than at the center area (exponentially-spaced conductors). The degree of conductor clustering (compactness) at the periphery of the grid should increase with an increase of the contrast between the surface and deep layers.

- When the surface soil resistivity becomes larger than that of the deeper soil layers, the clustering (compactness) ratio should decrease towards a uniform distribution of conductors in the case where the contrast ratio is significant (5 or more) and the thickness of surface layers is small compared to the size of the grounding system (1/5 or less).

- Finally, when the surface soil resistivity is quite large compared to the deeper layers and its thickness is small enough so that use of ground rods penetrating the deeper layer is efficient, a number of ground rods should be installed wherever possible to reduce the GPR, touch and step voltages instead of using unequally spaced conductors.

Based on the soil model and the initial design, we will combine the first and the third methods in this study.

7.1 SESCAD INPUT MODE

First, change the Current Job ID to TUT2 in the CDEGS Start-up Window. Select ‘Specify’ under the MALT computation module drop-down, select the Imperial System of Units and Start the SESCAD program. The input file MT_TUT2.F05 can be created by simply modifying MT_TUT1.F05. It can also be created by loading an already prepared file MT_TUT2.F05, as described in Section 4.1.1. The following describes how to create MT_TUT2.F05 using MT_TUT1.F05.
In the SESCAD program, load the MT_TUT1.F05, then save this file as MT_TUT2.F05. We first delete the existing grid and computation points. We will then create a new grid with a new set of points for computing touch voltages only. This is because the step voltages are already below the safe step voltage limit for the initial design of the grid, we will only examine the touch voltages in the substation for the reinforced grounding system.

As shown in the screen to the right, select both the computation profiles and existing grid by choosing Select All (or Ctrl+A) under the Edit menu. Press the Delete key to delete them.

Similarly to TUT1, the new ground grid is created by selecting Create Object | Detailed Grid under the Edit menu. Instead of using a linear grid like in TUT1, we will create an Exponential grid to effectively mitigate touch voltages towards the edge of the grid. First enter the values in the following screen. The compression ratio is set to 0.8 for both X and Y directions (a ratio of 1.0 means equally-spaced conductors and 0.0 means that all conductors are packed on top of each other at the periphery of the grid). Furthermore, the number of grid conductors has been more than doubled in both X and Y directions (Nab = 18 and Nac = 24). The radius of conductors is set to 0.017 ft. Then, click on the Apply button to create the grid and click on the Close button to close the window. Be sure not to click on the Apply button twice to avoid creating duplicate conductors.

To specify observation points for computing touch voltages only, select the grounding grid and select Tool | Generate Profiles. The Border Offset is set to 0 in order to examine touch voltages on the grounding grid only. As before in TUT1, the Distance between points is set to 3.5 ft and the
Distance between profiles is set to 2.5 ft. Click the OK button to generate profiles and then save the file.

In order to use the same soil model as the one used for the initial design, you have the following two options:

- Open the RESAP input file RS_TUT1.F05 and save as the new JobID TUT2 and resubmit the RESAP run.
- Or, simply copy the RESAP-MALT shared file SF_TUT1.F11 to SF_TUT2.F11 in the working directory.

Now, submit the MALT run as explained in Section 4.2 to carry out the new grounding computations. Do not forget to resubmit the FCDIST run as explained in Section 5.3 because the resistance of the new grounding system has changed from the initial one (although not by much). This will ensure that the fault current distribution between the grounding system and shield wires is re-computed based on the new ground resistance value. To resubmit the FCDIST run, you can simply load the file FC_TUT2.F05 by following the steps given in Section 5.2.1. The input file: FC_TUT2.F05 will be created.

Now, you are ready to re-plot the new applicable touch voltages (as explained in Section 6.2.1). Select ‘Examine’ button under the MALT computation module drop down on the toolbar of the CDEGS Start-Up window.

In SESResultsViewer screen Click the Computations radio button. Select Scalar Potentials option from the Category drop down list. In the Result Selection drop down list, select Touch Voltages. Select the Spot-2D from the Plot View menu. Click on Rendering button and make sure the Superpose Grid Configuration and Preserve Geometry Proportion boxes are checked. Click on the Plot button to get the following color 2D spot plot. This plot indicates that the maximum touch voltage is now reduced to 988.6 V, a value close to the target safe touch voltage of 936.6 V corresponding to a 0.3 s backup fault clearing time.

Note that there is no need to zoom-in to the area covered by the grounding system since the observation points are defined just to cover the grounding system.
In order to determine the area where touch voltages exceed the safe touch voltage limit of 936.6 V, enter a value of 936.6 in the **Threshold Value** field (you can also select the **Specify in Threshold Module** option as an input mode and invoke SESThereshold to compute the touch and step voltages thresholds). This instructs the program to display all touch voltage values exceeding 936.6 Volts with color gradation (white for values less than 936.6 V, green to red for values from 936.6 V up to the maximum value of 988.6 V). You can also click on the **Rendering** button to set the color of the values below the threshold by selecting a desired color as shown below.

Click on the **Plot**, the plot displayed below is produced. This figure indicates that we are very close to a safe ground grid design. The excessive touch voltages only occur near the four corners of the substation. By adding a ground rod at each corner of the grid, we will probably achieve a safe grounding system.
We will carry out this last design iteration by modifying the grounding analysis input data TUT2. First, change the **Current Job ID** to TUT3 in the CDEGS Start-up Window. Select ‘Specify’ under the MALT computation module drop-down list. Start the SESCAD program.

The input file MT_TUT3.F05 is created by load the **MALT** input file MT_TUT2.F05 and save it as MT_TUT3.F05. Note that you can also load the MT_TUT3.F05 which was prepared in advance in section 1.9. The **Run Identification** is changed to “SAFETY (TUT3)”. Note that as before you have to reload both the RESAP and the FCDIST screen under the new JobID TUT3 and resubmit the RESAP run **before** and the FCDIST run (use FC_TUT3.F05 as described in section 1.9) **after** the MALT run.

We suspect that the excessive touch voltages at the corners of the grid could be removed by installing four ground rods at the corners. The four rods are added easily in the SESCAD by using the **Create Rod** under the **Power Tools**. Click on the **Power Tools** button and select the **Create Rod** (the mouse is changed to a circle with a plus symbol in the center). By default the length of the rod is set to 10 ft. A 10 ft ground rod is created by clicking on each corner of the grounding grid. The following four conductors are created. The subdivision of each rod is set to 3.

<table>
<thead>
<tr>
<th>Xₛ (Feet)</th>
<th>Yₛ (Feet)</th>
<th>Zₛ (Feet)</th>
<th>Xₚ (Feet)</th>
<th>Yₚ (Feet)</th>
<th>Zₚ (Feet)</th>
<th>Radius (Feet)</th>
<th>Nₛᵤᵤ</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1.5</td>
<td>0</td>
<td>0</td>
<td>11.5</td>
<td>0.026</td>
<td>3</td>
</tr>
<tr>
<td>0</td>
<td>200</td>
<td>1.5</td>
<td>0</td>
<td>200</td>
<td>11.5</td>
<td>0.026</td>
<td>3</td>
</tr>
<tr>
<td>350</td>
<td>200</td>
<td>1.5</td>
<td>350</td>
<td>200</td>
<td>11.5</td>
<td>0.026</td>
<td>3</td>
</tr>
<tr>
<td>350</td>
<td>0</td>
<td>1.5</td>
<td>350</td>
<td>0</td>
<td>11.5</td>
<td>0.026</td>
<td>3</td>
</tr>
</tbody>
</table>
Resubmit this new case to produce the required input file then run MALT followed by FCDIST as explained in Chapter 4 and 5 respectively. Then request the MALT| Examine and plot the new computed touch voltages using the color 2D spot view option. Remember to select the Superpose Grid and Preserve Geometry Proportion options. You should get the following plot that confirms clearly that all touch voltages are now below 764.9 V.

Since touch and step voltages are well below our target safe values of 936.6 V and 3160.8 V respectively, the main engineering work is completed.
Further design iterations may be required to remove or reposition some conductors to more practical locations. Extra ground rods may be added to account for winter soil freezing or summer extreme drought conditions. In some cases, other soil structure models may need to be analyzed to account for inherent data uncertainties or known soil characteristic variations. In such cases, the worst-case scenario should be retained as a reference for the final recommended grounding design configuration.

At this stage, it is possible to send directly the grid configuration to a DXF compatible CAD drawing system. For example if your CAD system is AUTOCAD (or DXF compatible), you may proceed as follows:

In the SESCAD, select **Save Document As...** under the **Files** menu. Select the **DXF Files** from the **Files of types** and click on **OK**. The file **MT_TUT3.DXF** is created. Note that, you can also use the more advanced SESConverter tool to convert SES input files to DXF and AutoCAD DWG files. More details are available in Appendix B.

On a final note, it is worthwhile mentioning that when redesigning an existing grounding system (update, upgrade, etc.), you could import the actual system configuration from a DXF-compatible CAD file by clicking the **Import...** under the **Files** menu in the SESCAD (after a **New Document** is created in SESCAD). It is however important to note here that some drawings may contain overlapping lines which will ultimately result in invalid overlapping conductors in MALT. Furthermore, too many details such as short wire connections and bonding conductors have a minimal impact on the grounding design performance but a significant negative impact on the computations in terms of run time and run accuracy. One way to remove this kind of problem is to use the minimum conductor length threshold to ignore such non-significant short conductors. This strategy, however, can be used in MALT only and may have a negative impact on the node subdivision process.
7.2 EXPLORE RESULTS BY GRServer

You can also explore computation results by using the GRServer which can be started by clicking on the **GRServer** icon under the **Tools** tab in the CDEGS Start Up window. Because the last JobID used in the CDEGS window is TUT3, GRServer automatically loads the database files corresponding to this JobID. The three color bars corresponding to RESAP, MALT and FCDIST modules are all green and you are ready to make plots.

We will focus on exploring results corresponding to MALT. First, click on the MALT button to select the MALT program, and then close the RESAP TUT3 window. Click on the **Draw** button. The following scalar potential is plotted.
To make Spot-2D touch voltage plot, first select the **Spot** radio button under **Plot View**. Click on the **Plots** button *once* to see the general settings. Note that this button is now changed to the **Computations** button (the screen on the left below). Click on the **Computations** button and select **Touch Voltages** from the **Determine** field and click on the **Draw** button. The Spot-2D touch voltage plot is created.

You can explore many other options in GRServer in making enhanced graphics, as you wish.
7.3 EXPLORE RESULTS BY SESSYSTEMVIEWER

As mentioned before in Chapter 3, the SESSystemViewer is a powerful 3D graphics rendition tool that allows you to display computation results right on the system components in 3D. It can also visualize the complete system including the entire network, surrounding soil structure and display patches in finite volume soils.

The SESSystemViewer can be started by clicking on the SESSystemViewer icon in the CDEGS Start Up window tools tab. By default, Load an Existing Solution (JobID) is selected and you can click on the Browse button to select an existing database file (.F21). In this case, we will select MT_TUT3.F21 corresponding to the TUT3 JobID and the screen on the right appears.
Now, click on the **OK** to start loading the MT_TUT3.F21 database file into the SESSystemViewer. Note that the results in the SESSystemViewer should be scaled automatically because there exist a share file SF_TUT3.F11.

The following screen shows the scalar potential and the leakage current.

First, you can click on the **button to zoom out the scalar potential plot by dragging the left mouse button. You can click on the **button to rotate the scalar potential plot by holding down the left mouse button and by moving the mouse. You can use the **button (Pan Mode) to move the picture around.
If the computation results are displayed outside the view window, you can use the button to scale the results in Z-axis to bring it back into the view window.

To plot touch voltages, click on **Settings | Global | Observation Points Results Display | Touch Voltage Magnitude** and the plot below is generated.

To switch from a 3D Plot to a 2D-Spot plot, click on the button. You can use the + and buttons to change the view.
To plot leakage currents magnitude, click on **Settings | Global | Configuration Results Display | Leakage Current Density** and the leakage current plot below is generated. You can use the button to scale the results in Z-axis, and button to zoom in the leakage current density plot.
CHAPTER 8
CONCLUSION

This concludes our concise step-by-step instructions on how to prepare, submit and examine results for the simple grounding analysis problem described in this manual using the RESAP, MALT and FCDIST computation modules.

Only a few of the many features of the software have been used in this tutorial. You should try the many other options available to familiarize yourself with the CDEGS software package. Your SES Software distribution media also contains a wealth of information stored under the PDF directory. There you will find the Getting Started with SES Software Packages manual (PDF\getstart.pdf) which contains useful information on the CDEGS environment. You will also find other How To…Engineering Guides, Annual Users’ Group Meeting Proceedings and much more. All Help documents are also available online.
This page is intentionally left blank
Any of the interfaces listed below or a text editor can be used to prepare the input data. The Windows Toolbox input modes convert the results of an input session to a Command Mode compatible ASCII input file which can be edited at any time. This document describes the Windows Toolbox mode in detail.

- The Windows Toolbox mode.
- The Command Mode.
- Plain text editor mode.

Printout A.1 is the resulting RESAP Command Mode compatible input file, which analyzes the soil structure using the soil resistivity data in Table 2.1. This RESAP file can be edited directly by an experienced user or is automatically produced when using one of the above-listed input interface modules. Similar files can be prepared quite easily by following the information contained in the template shown below.

RESAP
TEXT,MODULE,SOIL RESISTIVITY ANALYSIS FOR EAST CENTRAL
TEXT,MODULE,SUBSTATION.
TEXT,MODULE,A TWO-LAYER SOIL MODEL
OPTIONS
   UNITS,BRITISH
   RUN-IDENTIFICATION,Substation Site #1
   PRINTOUT,DETAILED
MEASUREMENTS,APPARENT-RES
   METHOD,WENNER
   RESULTS,1.,152.3,.3,.2
   RESULTS,3.,48.16,.3,.2
   RESULTS,6.,6.14,.3,.2
   RESULTS,15.,3.34,.3,.2
   RESULTS,20.,1.76,.5,.2
   RESULTS,30.,1.11,.5,.2
   RESULTS,50.,.692,1.,.2
   RESULTS,75.,.441,1.,.2
   RESULTS,100.,.32,1.,.2
   RESULTS,150.,.218,2.,.3
   RESULTS,200.,.156,2.,.3
   RESULTS,300.,.106,2.,.3
   RESULTS,400.,.079,3.,.3
   RESULTS,500.,.064,3.,.3
SOIL-TYPE,MULTILAYER
   HORIZONTAL
   LAYER,Top,0,0.
   LAYER,Bottom,0.
OPTIMIZATION
   ACCURACY,0.025
   ITERATIONS,500
   STEPSIZE,0.0001
ENDPROGRAM

Printout A.1  RESAP Input File RS_TUT1.F05.
Figure A.1 RESAP Command Mode Compatible Input File Template.
Printout A.2 shows the required MALT input file MT_TUT1.F05 corresponding to the initial grounding system of the East Central substation. The two-layer soil model in Table 3.1 is used. This file can be edited directly by an experienced user or is automatically produced when using one of the input interface modules listed at the beginning of this appendix.

Similar files can be prepared quite easily by following the template shown in Figure A.2.

```
MALT

TEXT,MODULE,SAFETY STUDY IN THE 230 KV EAST CENTRAL SUBSTATION
TEXT,MODULE,INITIAL DESIGN OF GROUNDING GRID
OPTIONS
  UNITS,BRITISH
  RUN-IDENTIFICATION,SAFETY (TUT1)
  PRINTOUT,DETAILED
  NODE-SUBDIVISION,YES
COMPONENTS
  TEMPLATES
    GRID, DETAILED, -1, 0, 0, 0, .017, 7, 9
    CGRIDCOORD, 0, 0, 1.5, 350, 0, 1.5, 0, 200, 1.5
    SPACING, LINEAR
    GROUP,,0,1,,,

SYSTEM
  SUBDIVISION,YES
  AUTO-SUBDIVISION,PARTIAL,0.25

NETWORK
  MAIN-GROUND
    ENERGIZATION,CURRENT,1000.
    CONDUCTOR,0.,0.,1.5,350.,0.,1.5,.017,10,,1
    CONDUCTOR,0.,33.3333333333,1.5,350.,33.3333333333,1.5,.017,10,,1
    CONDUCTOR,0.,66.6666666667,1.5,350.,66.6666666667,1.5,.017,10,,1
    CONDUCTOR,0.,100.,1.5,350.,100.,1.5,.017,10,,1
    CONDUCTOR,0.,133.333333333,1.5,350.,133.333333333,1.5,.017,10,,1
    CONDUCTOR,0.,166.666666667,1.5,350.,166.666666667,1.5,.017,10,,1
    CONDUCTOR,0.,200.,1.5,350.,200.,1.5,.017,10,,1
    CONDUCTOR,0.,0.,1.5,0.,200.,1.5,.017,10,,1
    CONDUCTOR,43.75,0.,1.5,43.75,200.,1.5,.017,10,,1
    CONDUCTOR,87.5,0.,1.5,87.5,200.,1.5,.017,10,,1
    CONDUCTOR,131.25,0.,1.5,131.25,200.,1.5,.017,10,,1
    CONDUCTOR,175.,0.,1.5,175.,200.,1.5,.017,10,,1
    CONDUCTOR,218.75,0.,1.5,218.75,200.,1.5,.017,10,,1
    CONDUCTOR,262.5,0.,1.5,262.5,200.,1.5,.017,10,,1
    CONDUCTOR,306.25,0.,1.5,306.25,200.,1.5,.017,10,,1
    CONDUCTOR,350.,0.,1.5,350.,200.,1.5,.017,10,,1

COMPUTATIONS
  DETERMINE,POTENTIAL
  PLATE-METHOD,Surface-Integration
  OBSERVATION-POINTS
  POTENTIAL
    PROFILES,107,-10.0000003191,-10.0000003191,0.,3.49056594251,0.,0.,0
    SURFACE,89,0.,2.49999983979,0.,0

ENDPROGRAM
```

Printout A.2 MALT Input File MT_TUT1.F05.
Program Command

MALT

TEXT, Comment Line 1
TEXT, Comment Line 2

OPTIONS
RUN-IDENTIFI, Any-ID
UNITS, METRIC / BRITISH / INCH-RADIUS
NODE-SUBDIVISION, ON / OFF
ENDMODULE

Comments Section

Optional User Data

SYSTEM SUBDIVISION, ON / OFF
NETWORK

Main Ground Electrode

Current or Voltage
MAIN-GROUND, Number-of-Segments
ENERGIZATION, CURRENT / VOLTAGE, Volts or Amps
CONDUCTOR, Xo, Yo, Zo, Xe, Ye, Ze, Radius, Nseg

Return Electrode (Optional)

Current or Voltage
RETURN-GROUND, Number-of-Segments
ENERGIZATION, CURRENT / VOLTAGE, Volts or Amps
CONDUCTOR, Xo, Yo, Zo, Xe, Ye, Ze, Radius, Nseg

Buried Structures (Optional)

Current or Voltage
BURIED-STRUC, Number-of-Segments
ENERGIZATION, CURRENT / VOLTAGE, Volts or Amps
CONDUCTOR, Xo, Yo, Zo, Xe, Ye, Ze, Radius, Nseg

ENDMODULE

SYSTEM MODULE:
Specify Electrode Configuration & Energization

Figure A.2 MALT Command Mode Compatible Input File Template.
Appendix A. Command Input Mode

Multi-Layer Soil Type

SOIL-TYPE, MULTILAYER
HORIZONTAL
LAYER, TOP, Resistiv, Thick
LAYER, CENTRAL, Resistiv, Thick
LAYER, BOTTOM, Resistiv
ENDMODULE

SOIL-TYPE, LIMITED-LAYER
HORIZONTAL
LAYER, TOP, Resistiv, Thick
LAYER, BOTTOM, Resistiv
ENDMODULE

Finite-Volume Soil Type

SOIL-TYPE, FINITE-VOLUME
NATIVE-SOIL, Resistiv
VOLUME, Name, Resistiv, Total-Elements
FACE, Harvest, Harvest, Harvest, Harvest, Harvest, Harvest, Harvest, Harvest, Harvest, Harvest, Harvest
VERTEX, X, Y, Z

SOIL-MODEL CHARACTERISTICS:
Note: Spherical, Cylindrical and Vertical Soil Types Also Available

COMPUTATIONS
TERMS, Num_Terms_Limited-Layer/Num_Terms_Multi-Layer
ACCURACY, Accuracy
ACCELERATION
REACH, Num-Terms
GPR

Observation-Points
POSSIBILITIES
PROFILE, Num-Points, Xo, Yo, Zo, dX, dY, dZ
SURFACE, Num-Profiles, dX, dY, dZ
VOLUME, Num-Surfaces, dX, dY, dZ

Points for Evaluation of Soil Potentials

Points for Evaluation of Apparent Ground Resistance Function

Fall-Of-Potential, Resistance
POINT, Curve-Num, Xp, Yp, Zp
PROFILE, Num-Points, Xo, Yo, Zo, dX, dY, dZ
ENDMODULE

ENDPROGRAM

Run Terminator

Figure A.3 MALT Command Mode Compatible Input File Template (Cont’d).
Printout A.3 is the resulting FCDIST Command Mode compatible input file that describes completely the problem being modeled in the simplified current distribution analysis module. This file can be edited directly by an experienced user or is automatically produced when using one of the above-listed input interface modules.

```
FCDIST

TEXT,MODULE,SAFETY STUDY IN THE 230 KV EAST CENTRAL SUBSTATION
TEXT,MODULE,FAULT CURRENT COMPUTATION
OPTIONS
  UNITS, INCH-RADIUS
  RUN-IDENTIFICATION, FAULT (TUT1)
  PRINTOUT, DETAILED
  OUTPUT, BOTH
SYSTEM
  AVERAGE-SOIL, 100.0
  FREQUENCY, 60.0
  GRID, EAST CENTRAL

COMMENT, Earth Return Conductors Type: SIMPLE
TERMINAL, GREENBAY
  EARTH, 0, 2, 0.0
  SOURCES, CARTESIAN, 1225.88, -5013.0, 0.0, 0.0, 0.0, 0.0, 0.0
  SECTIONS, 66, 1056.0, 10, 0, 0.0
  PHASE, 16, 0, 92.5
  BUNDLE, 0, 115, 24, 0, 2
  NEUTRAL, CHARACTERISTIC, 0.0021, 2.83058, 0.1925, 0, 2, 2
  CLASS_INFO, alumoweld, 60, 0
  CONDUCTOR_INFO, 7 No. 8
TERMINAL, HUDSON
  EARTH, 0, 3, 0.0
  SOURCES, CARTESIAN, 722.02, -6452.57, 0.0, 0.0, 0.0, 0.0, 0.0
  SECTIONS, 27, 1056.0, 28, 0, 0.0
  PHASE, 16, 0, 92.5
  BUNDLE, 0, 115, 24, 0, 2
  NEUTRAL, CHARACTERISTIC, 0.0021, 2.83058, 0.1925, 0, 2, 2
  CLASS_INFO, alumoweld, 60, 0
  CONDUCTOR_INFO, 7 No. 8
TERMINAL, NEWHAVEN
  EARTH, 0, 3, 0.0
  SOURCES, CARTESIAN, 744.90, -5678.771, 0.0, 0.0, 0.0, 0.0, 0.0
  SECTIONS, 35, 1056.0, 28, 0, 0.0
  PHASE, 16, 0, 92.5
  BUNDLE, 0, 115, 24, 0, 2
  NEUTRAL, CHARACTERISTIC, 0.0021, 2.83058, 0.1925, 0, 2, 2
  CLASS_INFO, alumoweld, 60, 0
  CONDUCTOR_INFO, 7 No. 8
ENDPROGRAM
```

**Printout A.3   Structured FCDIST Input File FC_TUT1.F05.**

Similar files can be prepared quite easily by following the information contained in the template shown in Figure A.4. The following section describes the Windows-compatible Toolbox input session which, once completed, generates the command mode compatible input file (.F05 file extension) similar to that described in Printout A.3 as well as a Windows Toolbox compatible file (.F05 file extension) both of which can be reloaded during subsequent sessions.
Appendix A. Command Input Mode

**Figure A.4** FCDIST Command Mode Compatible Input File Template.
SESConverter is a specialized software tool that can import/export CAD files to various SES software package SICL compatible input files. Currently, generic DXF (Drawing eXchange Format) files and AutoCAD proprietary DWG files can be converted to *.F05 files and vice-versa.

To use the converter tool, run the program from the start menu: “Start\All Programs\SES Software (Your Version)\Tools\SESConverter ”. Figure B.1 shows the SESConverter main window.

![SESConverter Main Window](image)

From the main window, in the convert option list, select "DXF-DWG to SES" to import a DXF or DWG CAD file. Note that other options are also available to export SES input files to CAD files. In this document, we will focus on how to build an SES compatible electrical model of the grounding grid from the previously prepared CAD file.

For this purpose, enter the name of the DXF (or DWG) file to be imported under **Generic DXF or AutoCAD DWG File Name**, or use the browse button to locate the file. Hereinafter, the process for importing the reinforced grounding grid in section 7.1 for JobID TUT2 is shown.

When the DXF (DWG) file is loaded into SESConverter, the data will be loaded into three grids: **Layers, Entities** and **Blocks** as shown in Figure B.2. Note that depending on the complexity of the CAD file, one may have different layers and entities. From this list, it is possible to discard any extra layers/entities, and select only those which are required for the grounding study. Moreover, the model contained within the DXF or DWG files is displayed graphically based on the items selected within the three grids. Using the Show column, you can view or hide the various items in the input file.
As you can see, the **Layers** grid will show various information of the imported CAD file. The DXF layer name and color, the conductor radius of each layer to be considered in the output *.F05* file, and the SES Network layer will be shown in this window. Note that using SES Network column you can assign MainConductor, ReturnConductor, BuriedConductor, MainPlate, ReturnPlate, BuriedPlate, MainRod, ReturnRod and BuriedRod as a network layer to the imported objects. Upon selecting each layer, more information will be shown in the **Entities (Blocks) in Selected Layer** expander, including the names and numbers of all entity types. Moreover, you are able to select only those particular entities that should be included during the conversion process. For example, the TUT2.DXF file has only one layer named MainGround_0 consisting of 42 LINE entity. Also, note that the radius of the conductors in the MainGround_0 layer has been assigned to 0.0328 ft which is the default value of the conductor radius. This default value can be modified to 0.017 ft in the **Import** tab in **Options | Settings** menu as shown in Figure B.3. Note that you can also change the output units, the default values for rod radius, rod height and maximum Z coordinate, and also control some tolerances, such as the minimum conductor length, the tolerance distance between conductor length and especially the number of segments while converting arcs and circles entities.
Now, you can run the case by pressing the Convert button. The generated SES file is saved under the same folder as your input .dxf file, with the same name as the .dxf, but with the appropriate prefix (i.e., MT_, MZ_, or HI_...), depending on the choice made in the CDEGS File Type drop-down list, and with the file extension “.f05”. Once the converted file MT_TUT2.F05 is generated, you can open it in SESCAD as before and follow the instructions in section 7.1 to complete your grounding study.

On the last note, it is worth mentioning that you can also specify the correspondence between entity color numbers, as defined in DXF or DWG file, and the radii of conductors by using the Color Radius Mapping option of the SESConverter tool. For this purpose, go to Options | Settings, in the General tab click on Color Radius Mapping to open the Color to Radius Editor. Define the mapping as shown in Figure B.4 and then run the file to do the conversion and generate the corresponding F05 file. For additional information, you can consult the context-sensitive help by pressing the F1 key.

![SESConverter Color Radius Mapping](image)

**Figure B.4** SESConverter Color Radius Mapping.
This page is intentionally left blank